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GETTING FAMILIAR WITH THE NEW LAYOUT
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EasyWorship 6 introduces a whole new experience from previous versions, making it sim-
pler than ever to build and present a schedule. If you've used previous versions, you'll
recognize the flow: using the Resource Area on the bottom to build the Schedule on the
left and then present from the Live Area on the right. You can still double-click any item in
the Schedule or Resource Area to Go Live immediately, and additional menu options
have been tucked into menu dropdown buttons located in the corners of each section of
the interface.
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RESOURCE AREA
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A collapsible Resource Area now spans the bottom of the application instead of being con-
fined to the bottom left. At the top are five tabbed libraries: Songs, Scriptures, Media,
Presentations, and Themes. The Resource Area has three columns: 1) Resource
Library/Collections tabs on the left, 2) Library lists and details in the middle, and 3) a Com-
pose Area on the right. Additional menu options are now in dropdown buttons in the bot-
tom left of the Resource Library and Library lists/details Areas, including Add ltem and
Action Menu buttons +~| =~ . In the Library lists/details Area, you'll also notice an Icon

View dropdown with a slider that allows you to customize your view for thumbnails or list
view | =] +/.

1. Presentations - Presentations in the Resource Area will house any EasyWorship
presentations you build in EasyWorship and PowerPoint slideshows. You’ll now have
a complete searchable library of presentations at your fingertips. No need to go
searching your hard drive for a PowerPoint file when it's right there in EasyWorship.

2. Themes - The themes area is now available to allow you to make templates that you
can apply to scripture, songs, and presentations. The responsibility of what used to be
called backgrounds is now handled between media and themes. Both will be available
in the song editor for convenient access. You'll no longer have to load media items in
two separate libraries to have backgrounds available in the song editor.

3. Collections - The resource area now gives you the power to create collections based
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on criteria you define. i.e. You can create a collection of songs that are written by the
same author or create a collection of videos or images that have cross in the name.

SCHEDULE AREA
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The biggest change to the Schedule Area is the addition of collapsible slide groups, allow-
ing you to drag-and-drop media to a single slide within a group or to the entire group at
one time. Additional menu options are tucked into dropdown buttons in the top right of the
Schedule Area, including an Icon View dropdown with a custom slider and an Action
Menu dropdown &3 +| =~ .

LIVE PREVIEW AREA

The Live Preview Area allows you to see the current live slide that the audience is seeing
as well as any sub-slides that are a part of the active slide group, e.g., multiple slides
within a song, looping presentation or a long scripture reference. This is different than pre-
vious versions where the middle Preview Area was for previewing what was queued to
Go Live.
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SEARCH

B EasyWorship - Default (=R E=m=
File Edit Live Profiles Help

-l B =T = < (== |
Open New Web Go Live Logo Black Clear Live
Schedule - 141207 Worship_2n... 33 v | 2 | Live - We Will Glorify #3 = | Live Output

-"—‘ We Will Glorify

i‘r\hs.hnd Did My Savior L.

notes

- Genesis 1:1 (HCSE)

=

—

Verse 2

We will glorify the King of kings
We will.alorifvithe Lamb
We wi' ~~fllords

6770

g hpm_are_you_smarter_no...

e 7 oMET®.

Songs  Scriptures | Media | Presentations  Themes

MEDIA Title ’ File Name
il Videos »
3] Images .
A Feeds fp_snow fallin... hpm_are you_..  hpm_christma..  im_ib05_colors..  img_ka3 CIlck to Cha nge
@ ovo
5 udio . search modes.
e Q m - ¥
i
MY COLLECTIONS
mop_inside to..  pgm blueand.. = pgm greenra..  swautumnsu..  sw_blue rushsS..
v e | o 1of 14 items -

Previously limited to songs, search has now been expanded to all libraries within the
Resource Area with two different search modes.Search by resource title, by scripture ref-
erence, or by keyword. Toggle between search modes by clicking the icon on the left side
of the search box = Genesis1.

Back to Top
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BUILDING YOUR FIRST SCHEDULE

In This Article:

Overview

STEP 1: Build with Drag & Drop

STEP 2: Edit Schedule Items

STEP 3: Save & Transfer Your Schedule
STEP 4: Present Your Schedule
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OVERVIEW

The Schedule Area in EasyWorship allows you to build a playlist or "set list" of items you
want to present during your worship service (e.g., songs with backgrounds, scriptures,
PPT slides for the sermon, live camera feeds, a mini-movie for offering or a sermon illus-
tration, a website, and lots of other options). This article will introduce you to the basics of
how to build your first Schedule, how to edit and re-order the items within the Schedule,
and how to save it as a file so that it can be shared with other users.

To get started, let's add some items to the Schedule Area.

STEP 1: BUILD WITH DRAG & DROP

Add Items

Adding items to your Schedule is as easy as dragging and dropping a song, scripture,
media item or presentation from the Resource Area below to the Schedule Area. Try
adding a few items to your Schedule.
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Let's say you want to start your next service with a mini-movie opener. To add a mini-
movie, go the Resource Area and click the Media tab.

Select Videos from the list on the left.

Click the + (add) button below, search for your mini-movie file, then click Open to add
the file to your Resource Library.

Now, just drag-and-drop the video file from the Resource Area to your new Sched-
ule.

Adding more items to your Schedule is just as easy. To learn more, see Add a Song or
Add a Scripture.

Re-Order Items

Drag-and-drop Schedule items around to re-order your set list.

Customize Your View

Customize the icons in the Schedule Area as small, medium, large or list view. Just click
the drop down arrow at the top of the Schedule Area and use the slider to customize the
icon view.
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Assign a Background or Audio to Songs

It's easy to add a background, camera feed, or audio track to your song slides.

1. Click on the Media tab in the Resource Area.
2. Select Videos, Images, Feeds, or Audio from the left.

3. Clickon anitem from the Resource List Area on the right and drag-and-drop it on
top of a song in the Schedule Area. That item has now been assigned to the song in
the Schedule. The song's master thumbnail in the Resource Area will reflect your
changes. (You can assign audio to a slide or song even if you have already have a
background assigned to it.).

You can also assign a background or audio to an individual slide within a group of slides.

1. Click on the arrow next to the song slide in the Schedule Area.The slides will expand
so that you can see each individual slide for the song.

2. Now, drag-and-drop a media item to an individual slide.

Dragging a media item onto the master slide of a song will apply the background to all
slides, even slides that already have a background assigned to them. (For more about cus-
tomizing slides, see Customize Song Slides).

NOTE: If you want to use the same background for all songs, you can set a default back-

ground. In the Resource Area, right-click on any media item and click Set Default, then
select Song Background.
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Back to Top

Creating Announcement Loops

Announcement loops can be created in EasyWorship or in PowerPoint and loaded into
the presentations tab. The announcement loop will be added to the Schedule from the
Presentations tab where all EasyWorship Presentations and PowerPoint slideshows are
stored.

For more information on how to create announcement loops, Announcement Loops.

STEP 2: EDIT SCHEDULE ITEMS

To modify a song, scripture or presentation that is already in the Schedule Area:

Right-click on the item in the Schedule.
Select Edit Item.

When the Editor Window appears, make the changes that are needed.

A e N -

Click OK to save the changes to the Schedule.
Add a Note or Reminder to a Schedule ltem

If you want your tech team or a volunteer user to know something about a particular
Schedule Item, just add a note to it. It takes seconds to create, and will appear under the
item name in the Schedule Area.
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Right-click on any item in the Schedule Area.
Select the option to Edit Notes. The Notes field will now contain a blinking cursor.

Type a note or reminder.

Ao Dd -

Click outside the Notes field to save the note to that item.

STEP 3: SAVE & TRANSFER YOUR SCHEDULE

You'llwant to save your Schedule at some point. Maybe you need to email your Schedule
file to someone, or save it to a memory stick or cloud service. No matter what you need to
do with your new Schedule file, follow these steps to get started.

1. Click the Save icon in the main toolbar.
2. ORclick File in EasyWorship's main menu and select the option to Save Schedule.

3. Name your Schedule file and click Save.

NOTE: EasyWorship will save your new Schedule file to a default location. If you would like

to save to another location (e.g., memory stick), be sure to navigate to that location before
clicking the Save button.

Everything you add to the Schedule will be packed into the Schedule when you save it...all
in one file. Simple! It's an easy way to take one file to another computer and open it to start
your worship service.

Open & Use an Existing Schedule

If you want to use a Schedule file you've received from someone else, it's easy to get con-
tent from the Schedule to the screen.

1. Click the Open icon in the main toolbar.

2. OR click File in EasyWorship's main menu and select the option to Open Schedule.
3. Navigate to the Schedule File and click Open.
4

. When the Schedule opens in EasyWorship, select an item in the Schedule Are and
click Go Live = . EasyWorship automatically selects the next item in the Schedule

so all you need to do is click Go Live again to send the next item to the screen. If you
don't see the item on the live screen, make sure you've clicked the Live button ﬁlj on

the far right of the main menu.

-10-
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STEP 4: PRESENT YOUR SCHEDULE

1. Select the firstitem in the Schedule and click the Go Live button GIO_EJL“J! on the toolbar. If
you don't see the item on the live screen, make sure you've clicked the Live button .
on the far right of the main menu.

2. When you are ready to send the next item to the screen click Go Live again.

Using Logo, Black, Clear
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Logo Button

At the beginning or end of a presentation, you might want to display a generic logo or title
screen. The Logo button allows you to quickly display an image (or video) that has been
assigned as the logo background. Here's how to assign an image as the logo:

1. Inthe Resource Area, click on the Media tab, select Images from the Resource
Library on the left.

2. Right-click the image in the Resource List Area to the right.
3. Select Set as Default and then click Logo Background.

Black Button

-11 -
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Mistakes happen. When you need a quick save, the Black button is a quick and easy
way to transition the entire screen to black.

Clear Button

The Clear button removes text from the screen while leaving the background running.

Back to Top

-12-
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DUAL MONITOR SETUP

In This Article:

Video Card Configurations for Windows Extended Desktop

Dual Monitor Troubleshooting
Enable Windows Extended Desktop
Setting Up EasyWorship to Use Your Second Monitor
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Intel Graphics Monitor Setup

EasyWorship is designed for dual monitor display. That means it can produce two dif-
ferent displays at the same time. The first display--Monitor #1 or the primary monitor--
goes to the control screen, which is what the operator sees. The second display--Monitor
#2 or the secondary monitor--goes to the output screen that is projected to the con-

gregation (this could be a TV, projector, or LCD screen). This kind of "Dual Monitor Dis-
play" makes it possible for an operator to be editing the Schedule Area in EasyWorship
while the congregation is viewing only the current song, scripture, video, presentation, or
feed.

EasyWorship uses Windows extended desktop to accomplish this. The following are
three different video card configurations that will allow you to use Windows Extended
desktop:

VIDEO CARD CONFIGURATIONS FOR WINDOWS EXTENDED
DESKTOP

1. Two video cards with a single output on each card. Works with desktop PCs only.
(Not recommended)

2. Asingle video card with two outputs. Works with desktop PCs only.
(Recommended)

3. Alaptop with a video output (VGA, DVI or HDMI) on the side or back of the laptop.

-13-
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Common ways to set up a computer for dual monitor output.

1.

EasyWorship may be set up with a single monitor on the desk to control the software
(Monitor #1) and with a projector as the secondary output (Monitor #2).

Customers using laptops will use their laptop monitor as the control monitor (Monitor
#1) and the output on the side or back of the laptop for output to the audience (Monitor

#2).

You may also add a video splitter to the secondary output. This would allow you to
have two secondary outputs (live screens) or a second monitor on the desk as well as
a secondary output for the audience.

NOTES: See for instructions on how to check a

computer for Dual Monitor compatibility and for instructions on setting up Dual Monitors to

use with EasyWorship.

DUAL MONITOR TROUBLESHOOTING

If your problem cannot be resolved by following the steps below, contact our Customer
Support Team via email at support@easyworship.com.

ISSUE

1. I seethe same thing on
my second monitor as |
see on my primary mon-
itor.

2. | enabled the Windows
extended desktop, but it

disables itself after | apply

the setting.

3.  Windows extended
desktop is enabled, but
EasyWorship still dis-
plays the output on my
primary monitor.

CAUSE

Your windows desktop has
not been extended to the
second monitor.

You have an Intel Graphics
card, or you do not have
your projector connected to
your secondary video port,
or the projector is not turned
on.

The secondary monitor is
not selected as the output
monitor in EasyWorship.

RESOLUTION

Enable the windows exten-
ded desktop. See below:
Enabling Windows Exten-

ded Desktop.

Use the instructions in Intel
Graphics Monitor Setup
to enable the windows
extended desktop for your
Intel Graphics card. Con-
nect your projector or sec-
ondary monitor to the
secondary monitor port on
your graphics card and
make sure that the monitor,
or projector, is turned on.

Click the Edit menu, then
Options. In the Live set-
tings, Select Monitor 2
(Secondary) for the Output
monitor. Click OK.

-14-


mailto:support@easyworship.com

EasyWorship 6 Manual: Dual Monitor Setup

Back to Top
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ENABLE WINDOWS EXTENDED DESKTOP

1. Open EasyWorship.

2. Click on the Edit menu.

3. Click Options.

4. The Options dialog box appears.

» Options =3 =R
Live Live Options
Song Select Qutput Monitor

Seripture Qutput Menitor | Custom Position - TriprlrEsen
Presentation Left [i] &
Alpha Channel Disabled hd

Foldback Top O
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Scripture
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Right 0 3 Bettem O <
Auto Sizing
verse 1 —
=ong text line one Maximum font point size 46 =

song textline two

song text line three
song text line four
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5. Select the Live tab on the upper left.
6. Inthe section titled Live Options, click the Monitor Setup button.

7. EasyWorship will open the Screen Resolution dialog box.

[E=% ECR =58

{ H pv|!J <« Displ.. » Screen .. vl‘f” Searc

Change the appearance of your displays

Display: 2. SyncMaster «

Reszolution: 1024 = 768 (recommended)

Multiple displays: IShow desktop only on 1 V]

Make this my main display Advanced settings

Make text and other items larger or smaller

What display settings should I choose?

oK || Cancel Apply 16 -
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13. Now you need to set up EasyWorship to use your second monitor. To do this, follow

the instructions below.

SETTING UP EASYWORSHIP TO USE YOUR SECOND MONITOR

EasyWorship will normally find the secondary display and automatically send the output to

that screen. However, you may need to set up the
tions below will walk you through the process.

output screen manually. The instruc-

1. Open EasyWorship
2. Click on the Edit menu.
3. Click Options.
4. The Options dialog box appears.
k3 Options EI
! [ ive Options
Seng Select Output Monitor
Scripture Output Menitor Qutput Position
Presentation Left [i]
Alpha Channel Disabled A
Foldback Top 0
Song Width 1024 5
Scripture Height 768 =
Miscellaneous
Advanced
Screen Margins
Transitions = +
Left 0 = Top 1] =
Right 0 = Bottom 0 =
Auto Sizing
Maximum font point size 46
SE—

5. Selectthe Live tab on the upper left.

6. Inthe section titled Live Options, click the Output Monitor dropdown and select Sec-

ondary Monitor.
7. Click OK.

-17 -
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INTEL GRAPHICS MONITOR SETUP
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Right-click on the Windows Desktop.

Click Graphics Properties.

Under Devices or Display Devices, click on the Extended Desktop option.
The Primary Device should be set to Notebook or Built-in-Display.

The Secondary Device should be set to Monitor.

Click OK.

Open EasyWorship

Click on the Edit menu.

Click Options.

Under Live, go to Select Output Monitor and select Secondary Monitor from the
drop down list.

. Click OK.

Back to Top
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DOWNLOADING FREE MEDIA

EasyWorship comes with a collection of free media that you can download within the soft-
ware. The following instructions will walk you through downloading your free media.

Open EasyWorship.

Click on the Web Button on the toolbar at the top.

Select Media at the top left of the web area if you are not already in the media store.
Click My Account at the top right of the media store page.

Click the DOWNLOAD FREE MEDIA button.

Hover your mouse over each media item and a download button will be provided.

N o g k0w N =

Click the appropriate download button.

EasyWorship 6 will support either mp4 or wmv file formats, so you can download
either format. When provided the option for HD content, you may need to select SD if
your computer seems to lag when play HD video files through EasyWorship.

8. The downloaded items will appear in the media area in their respective folders (videos
ore images).
If the image or video thumbnail looks faded, that means EasyWorship is still down-
loading the file.

-19-
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PURCHASING & INSTALLING BIBLES

EasyWorship has many free bibles available. There are also many copyrighted bibles
available for purchase as add-ons.
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1. Open EasyWorship.
2. Click onthe Scriptures tab in the Resource Area.

3. Atthe bottom of the Scriptures list on the left (list of currently installed bible versions),
click the link for More Available...

4. Inthe list of available Scripture versions on the right you can see a full list of free and
purchasable bible versions. If the bible you want to install is free, click the Free button
next to it to install.

5. Ifabible you wantto add is not free, click the Buy button on the right. In the new win-
dow, log in to your EasyWorship account using your email and password. If you do not
have an account, click on Create New User and enter in the appropriate information
to create an account.

6. Once you are logged in, make sure you're connected to the correct Organization and
click Buy.

7. A window will open to complete your purchase. Enter in your payment information
and click Place Order. When the order is complete, EasyWorship will automatically
download and install the bible.

-20-
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8. If you purchased a bible on easyworship.com or worshipmedia.com, the bible will
show as installed when you're logged into EasyWorship with your account.

-21-
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ANNOUNCEMENT LOOPS

Announcement loops are a great pre- or post-service communication tool. Whether you're
sending announcements to a lobby kiosk or presenting on the main screens in your aud-
itorium, this article will show you how to get started.

Slide loops are created in the Presentations Area of EasyWorship. When you're ready to
play the loop, simply drag-and-drop it to the Schedule Area and click Go Live or just
double-click it to send it to the screen. The slides within the Presentation will loop until you
Go Live with the next item in the Schedule.

Let's get started creating an announcement loop.

& # & |
I’wPreﬁentaliunEditorrUntwlled o &= ]
- | =@ T B 8. =.| @
| o =Y Theme Text  Scripture  Media Amange | Inspector
‘?a_wma v 65 « av aAs [ FEz s EE) =F = = Reset to Defaur

Words | Slides

105
Presentation Attributes

Aspect Ratio Auto

[¥] Boop Presentation

1. First, create a new presentation (click on the Presentations tab in the Resource Area
and click the + [add] icon below) or right-click an existing item in the Resource Area or
the Schedule Area and select the option to Edit Item.

N

Once the Editor Window comes up, click the Inspector button in the top right
corner.

. Click Presentation on the left and check the option to Loop Presentation.

3
4. Next, click Transition under the Slide settings on the left.
5. Setthe transition and any other options you wish to set.

6

. Change the Advanced Slide option to Automatically.
L Anthe field for After setthe number of seconds vou wish to wait before transitioning

-22.
8. Click Apply to Theme to apply this setting to all of the slides in the presentation.
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9. Close the Inspector and enter a name in the Title field at the top of the Editor Win-
dow and click OK to save your changes.

NOTE: These instructions apply only to EasyWorship presentations, songs or scrip-

tures. PowerPoint loops cannot be set up using these instructions.
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COMPOSE

OVERVIEW

For on-the-fly editors and designers, the Compose Area is the quickest way to change a
background, select an audio track, or apply a theme to a song or scripture at the last
minute. In the Compose Area, you can choose to send an item to the live screen imme-
diately, or add it to the Schedule for later.

The Compose Areais located in the bottom right corner of EasyWorship, next to the
Resource Area.
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Compose a Song

1. Clickthe Songs tab in the Resource area.
2. Select the song you want to compose.

3.
4

. To send the composed song to the live screen, click the Play button above the Com-

Click the Compose button in the bottom right corner of EasyWorship.

pose Area.

To add the composed song to your schedule, click the Plus button above the Com-
pose Area.

» Change the Background: Click the Media tab, click on Videos,
Images, or Feeds, and double-click the file you want to use at the
background.

» Select Audio: Click the Media tab, click on Audio, and double-click
the audio file to attach it to the song.

» Select a Theme: Click the Themes tab, then double-click the desired
Theme to use on the song.

Compose a Scripture

1. Click the Scripture tab in the Resource Area.
2. Select the scripture(s) you want to compose.

3.
4

. Tosend the composed scripture(s) to the live screen, click the Play button above the

Click the Compose button in the bottom right corner of EasyWorship.

Compose Area.

To add the composed scripture(s) to the schedule, click the Plus button above the
Compose Area.

» Change the Background: Click the Media tab, click on Videos,
Images, or Feeds, and double-click the file you want to use at the
background.

» Select Audio: Click the Media tab, click on Audio, and double-click
the audio file to attach it to the song.

» Select a Theme: Click the Themes tab, then double-click the desired
Theme to use on the song.
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Undo Compose Changes

1. If you have selected a background, audio file, or theme and want to undo or cancel it,
click the Background Button, Audio Button, or Theme Button at the bottom of the Com-

pose Area to undo that selection.

2. Ifyouwant to cancel compose (get out of the compose feature), just click the X button
in the bottom right corner of the Compose Area.

NOTE: Once you click the Compose button, Compose mode will stay active until you

either add the active item to your schedule, Go Live with it, or cancel Compose mode.
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DVD CLIPS

In This Article:

Intro to the DVD Feature

DVD Clip Editor Overview

Create a DVD Clip

Using a DVD Clip in the Schedule
Edit a DVD Clip

Delete a DVD Clip

Setting DVD Region

DVDs Explained

® N o o bk~ w0 D=

INTRO TO THE DVD FEATURE

EasyWorship lets you use your computer's DVD drive to show segments of a DVD during
a presentation or service, e.g., a missions update, sermon illustration or service intro.
Quickly select entire segments or chapters of a movie, or set custom In and Out points to
show only a short clip. EasyWorship was not designed to copy or burn video files from a
DVD. Instead, EasyWorship lets you create custom "markers" that tell EasyWorship
exactly what to play from the DVD. That means the DVD has to be in the DVD drive for
this feature to work.

Layout

To start exploring the DVD feature, click the Media tab in the Resource Area and then
click on the DVD icon in the Media Library (see illustration below).There are three icons
across the bottom of the DVD clip library.

1. Add New (+) Icon: Click this icon to open the DVD Clip Editor window and create a
new DVD clip.

2. Action (Gear) Icon: Click this icon to add a new DVD clip, edit or delete a selected clip,
customize the thumbnail view,customize the clip sort order, or refresh your clips.

3. Thumbnail View Icon: Click this icon and use the slider to customize the thumbnail
view in the DVD clip library.
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Songs  Scriptures | Media | Presentations Themes
MEDIA Title B File Name
i Videos
[l Images
(=) DVD
[44] Audie
| COLLECTIONS
I- MY COLLECTIONS
| e + | | 0 items =

To access the DVD Clip Editor, right-click anywhere in the DVD clip library area and
select Add New DVD Clip from the pop-out menu, or click the Add New (+) Icon. Ifa
DVD isin the DVD drive when the DVD Clip Editor window pops up, EasyWorship will
begin playing the DVD just like a normal DVD player. Using your mouse, click on the
chapter menu in the preview window and navigate to the desired chapter or segment. The
DVD Clip Editor gives you a number of options for selecting clip segments and adjusting
clip volume.

For step-by-step instructions on creating a DVD clip using the DVD Clip Editor, see
Create a DVD Clip.

Properties Tab

[ DVD Clip Editor = [ 2|23

DVD Clip Editor
L= Create and manage DVD clips for use in EasyWorship

PROPERTIES INFO

Title o

00:00:00.00 5 E] Mark In

il:i Mark Entire Segrment

Aspect Ratio

Aspect Ratic | Automatic Vi I'
! e a 6?-5:491’40:?—5 Audio Properties
? 44 | pp | (E= (-

o) O h @‘u‘olume () w0 £ Mute

Selectari\re - [ OK ] | Cancel

Clip Properties

1. Play / Pause: The play/pause button starts and stops the video playback.

2. Fast-Forward / Rewind: Single clicking skips forward or backward one chapter.
__Menu: n allow he DVD Title Menu. Root Men ifl

4. Continuous Play / Repeat: button e_lllzogv_s you to loop the dvd clip you are viewing or

5. Mute & Volume: button and volume slider only controls the audio while working with
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Mute allows you to mute the audio on the DVD clip if you don’t wish to use the audio

portion of the DVD.
Back to Top
Info Tab
§» DVD Clip Editor = [(@ ]3]
DVD Clip Editor
LI Create and manage DVD clips for use in EasyWorship
PROPERTIES | INFO
Title (1]
Author 9
Copyright e 4
6 Description - 0 Tags =~ |

(9] 26:49 / 40:25
B 4 o = = o) O
Select Drive « 0K ] | Cancel

Title: Enter the name of the DVD clip in this field.
Author: Enter the Author in this field.
Copyright: Enter copyright info in this field.

A obd -

field.

© Button: Pressing the copyright logo button adds the copyright logo to the copyright

5. Description: This drop down allows you to enter a description for the DVD clip.

Tags: This drop down allows you to enter tags for the clip.
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CREATE ADVD CLIP

1. Inserta DVD into the DVD drive.

2. Clickonthe Media Tab in the Resource Area.

3. Click on the DVD Icon in the Media Library on the left.
4

. Right-click anywhere in the DVD clip library area and select Add New DVD Clip
from the pop-out menu, or click the Add New (+) Icon at the bottom of the DVD clip
library area.The DVD Clip Editor window will appear.

5. Type aclip name in the Clip Name field.

6. Using your mouse, click on the DVD chapter or title menu in the preview window and
navigate to the desired chapter or segment.

7. Asthe selected DVD clip plays, click the Mark In button to select the beginning of
your clip.

8. Click the Mark Out button to select the end of the clip.

9. The Preview button will allow you to preview your edited clip in the window. Click the
Edit button to resume editing.

10. Scroll the clip to find the frame you wish to use for a thumbnail and click Set Thumb-
nail.Click OK.

11. The clip and thumbnail will appear in the DVD clip database.

NOTES: To play an entire chapter or segment, click the "Mark Entire Segment" button. For
Integrity iWorship DVDs, and others like it, you can click "Mark Entire Segment" when a wor-

ship track starts playing. EasyWorship will set the Mark In and Mark Out points at the begin-
ning and end of the song for you.

WARNING |If the wrong region or no region is set for the DVD drive in your computer, you
will be able to create clips, but will NOT be able to play them back after removing and rein-
serting the DVD into the drive. To learn how to set the region for your computer's DVD drive,
see.Setting DVD Region below.

Back to Top

USING ADVD CLIP IN THE SCHEDULE

1. Selecta DVD clipinthe DVD clip database.
2. Drag-and-drop the clip into the Schedule.
3. When itis time for the DVD clip to be played in the service, just click Go Live .
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NOTES: To Go Live with a DVD clip directly from the database, double-click it. DVD clips

can be transferred via the schedule to another computer, but the DVD has to be in the drive
for the clip to play.

EDIT ADVD CLIP

1. Selectaclip inthe DVD clip database.
2. Right-click the clip and select Edit.

3. The DVD Clip Editor Window will appear, allowing you to make changes to the DVD
clip.

4. Click OK to apply the changes.

DELETE ADVD CLIP

1. Selectaclip inthe DVD clip database.
2. Right-click the clip and select Delete.

3. Click yes on the prompt that appears to verify that you want to delete the clip.

SETTING DVD REGION

In order to create DVD clips in EasyWorship, the DVD region has to be set on the DVD
player in the computer. Many DVD drives come from the factory with no region set. If the
wrong region or no region is set, you will be able to create clips, but will not be able to play
them back after removing and reinserting the DVD into the drive. Follow the instructions
below to set the region on the DVD drive in the computer.

1. Open Computer or My Computer or This PC.

2. Right-click the DVD drive.

3. Click Properties.

4. A properties window will appear.

5. Clickthe Hardware tab.

6. Selectthe DVD drive from the list.

7. Clickthe Properties button at the bottom.

8. The properties window for the DVD drive will appear.

9. Clickthe Changes settings button at the bottom of the General tab.
10. Clickthe DVD Region tab.
11. Select the appropriate country.

SO
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NOTE: The DVD region can only be changed a maximum of 5 times.

DVDS EXPLAINED

EasyWorship lets you use your computer's DVD drive to show segments of a DVD during
a presentation or service, e.g., a missions update, sermon illustration or service intro.
Quickly select entire segments or chapters of a movie, or set custom In and Out points to
show only a short clip. This is different than capturing a DVD feed through a capture card.
It's also different than copying or burning video files from a DVD. Instead, EasyWorship
lets you create custom "markers" that tell EasyWorship exactly what to play from the
DVD. That means the DVD has to be in the DVD drive for this feature to work.

DVD Structure

The video content in a DVD is divided into titles and menus. Titles are further divided into
units called parts of titles (PTTs). More often, these are called scenes, chapters or seg-
ments. These could be compared to using folders and sub folders in your directory tree
structure of a computer. The viewer can navigate to specific titles or chapters within titles.
Each individually separated video file on a DVD may be referred to as a segment.

The author of a DVD decides how to divide the content into titles and chapters. When a
DVD contains a feature-length film, the entire film is often placed in one title or segment,
and sometimes divided into chapters for the individual scenes. Extra features on the DVD,
such as trailers or deleted scenes, are placed in separate titles or segments. However,
these divisions are arbitrary, and many DVDs are organized differently.

The EasyWorship DVD editor can play the entire movie, predefined segments or you can
select parts of the DVD called clips. On any DVD, you may set Mark In and Mark Out
points to edit a clip. You may define a clip name for that edited clip. The DVD from which
you wish to play a clip must remain in the DVD ROM drive. EasyWorship does not copy
the DVD or segments, only a path to turn on that selected segment or clip. If you have mul-
tiple drives, EasyWorship will remember the drive from which you edited your specific clip.
Multiple clips or segments may be chosen from your DVD.

Back to Top
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INSPECTOR

In This Article:

Info
Presentation
Slide

Element
Text
Media

o g M 0w N =

The inspector is available in the Song editor, Presentation editor, Theme editor & Sched-
ule editor. It allows you to make additional formatting changes to selected elements.

m Schedule Editor - Create In Me A Clean Heart |?‘IE”§|
| CreateIn Me A Clean Heart . = ‘ 3 Bl I i
. @ T @ = & [ 0
O = ¥ Theme Text  Scripture  Media | Arrange Inspector
As fault
. s i Inspector - (1] i
Words | Slides
1[4 Chorus1 ?
Create in me a clean heart Presentation
O Lord my God Title Create In Me A Clean Heart
And renew a right spirit within me slide
Create in me a clean heart Author
O Lord Cod Background
iy ; Copyright ©
And renew a right spirit within me Audio Pyrg
2 Versel Transition Administrator
Cast me not away from Thy presence O Lord Element S Rmber
Take not Thy Holy Spirit from me &
Restore to me the joy of Thy salvation Fill
And renew a right spirit within me Border
3[E| BRIDGE Shadow
Lord renew my spirit and restare my soul ———
44 Chorus 2
Create in me a clean heart Text
Q Lord my God Font
And renew a right spirit within me :
Within me Outline
- Shadow
+ | | Bullets =
Media cel

INFO

Add or edit information for the song's Title, Author, Copyright, Administrator and Song
Number. The Title field can also be used to view or change the name of a Presentation or
Theme.
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PRESENTATION

Set the Aspect Ratio for the Presentation (16:9, 4:3, Double or Triple-Wide) and select
whether or not to loop the Presentation.

SLIDE

The EasyWorship Editor allows you to edit songs, miscellaneous text, and song inform-
ation. When editing a song, you can choose either to save your edits to the song in the cur-
rent schedule only, or to save your edits to the song permanently in the song Resource
Area.

Background

Inspector - (2]

Info Slide Background

Presentation

Fill Style IGradient Fill -

Slide

i R : g Angle
Background | b= - *
Audio : =

Transition Colorl I -
Element Color 2 E]

Fill

[ Mirror Colors

Border l_J i
Opaci =
Shadow Rt

Reflection

Text
Font
Outline
Shadow
Bullets

Media

Apply to Therne ‘ | Revert to Theme

None
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Color Fill

1. Color Fill enables the Color selector so you can set the color of the fill.

2. The Opacity slider sets the transparency of the color fill.
Gradient Fill

1. Gradient enables the Gradient Fill controls.

N

The Style Selector provides horizontal, vertical or diagonal gradient styles to select
from.

The Angle dial and field allows you to set a specific angle for the gradient.
Color 1 sets the color for half of the gradient.

Color 2 sets the color for half of the gradient.

o g M w

Mirror Colors adds color 1 to each side of color 2. Opacity sets the transparency of
the gradient.

7. Opacity sets the transparency of the gradient.
Media Fill

1. Select Media allows you to browse and select media that has been added to the
media resources area of EasyWorship.

2. Media Type changes how the background image behaves.

3. Motion/Still Background stretches the image or video to fit the screen and if the
background is a video, it loops.

4. Movie or Picture does not stretch the video or image and does not loop if the back-
ground is a video.

Aspect Ratio sets the aspect ratio of the background.
Volume changes the volume of the media item being used as the background.

Mute mutes or unmutes the volume of the media item being used as a background.

© N o o

Opacity sets the transparency of the background media item.

Back to Top
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Transition
Inspector - (=
Info Slide Transition
Presentation Transition In
Slide Transition |B|EHE| T
Background Duration | | 00.50
Audio EaseIn El Ease Qut
Options
Element
Fill
Border
Shadow
Reflection [7] Lock background when possible
Tod [/] Always start slide from beginning
Font Advance Slide
CQutline Advance | On Click -
Shadow 0000 .00
Bullets o
|| Loop Slide
Media

1. Transition In drop down allows you to select the transition you wish to use for the
slide.

2. Duration sets the length of the transition from start to finish.

3. Ease In/ Ease Out: Controls whether the transition starts out fast and slows down or
starts out slow and goes fast. If the slider is all the way to the left it will start slow and
end fast. If the slider is all the way to the right it will start the transition fast and end
slow.

4. Options: When "Always start slide from beginning" is checked, the slide starts from
the beginning whenever it is displayed. When "Lock Background when possible" is
checked, the text will transition over the background and the background will not trans-
ition with the text. When the background is not locked, the background will transition
when the text transitions. This is most evident when using the push or wipe transition.

5. Advance Slide: Select On Click to manually control the transition with mouse or

6. After sets the length of time to wait before the transition begins.
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ELEMENT

Constrain Proportions: Locks the aspect ratio of the selected element so that when it is res-
ized the aspect ratio maintained.

Opacity: Controls the transparency of the selected element.

Fill

This area of the Inspector gives you control over the background of the selected element.
None

Color Fill

1. Color Fill enables the Color selector so you can set the color of the fill.

2. The Opacity slider sets the transparency of the color fill.
Gradient Fill

1. Gradient enables the Gradient Fill controls.

N

The Style Selector provides horizontal, vertical or diagonal gradient styles to select
from.

The Angle dial and field allows you to set a specific angle for the gradient.
Color 1 sets the color for half of the gradient.
Color 2 sets the color for half of the gradient.

Mirror Colors adds color 1 to each side of color 2.

A L

Opacity sets the transparency of the gradient.
Media Fill allows you to use any media item as a background.

1. Select Media allows you to browse and select media that has been added to the
media resources area of EasyWorship.

2. Media Type changes how the background image behaves.

3. Motion/Still Background stretches the image or video to fit the screen and if the
background is a video, it loops.

4. Movie or Picture does not stretch the video or image and does not loop if the back-
ground is a video.

5. Aspect Ratio sets the aspect ratio of the background.
6. Volume changes the volume of the media item being used as the background.

7. Mute mutes or unmutes the volume of the media item being used as a background.

8 Onaci e T ediol
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Border Style

This area of the Inspector provides the option to turn on borders for the selected element,
change border formatting, and adjust border placement on the edge of the element.

None

1. None turns element border on or off.

2. Outer places the border on the outside edge of the element.

3. Center places the border on the center of the edge of the element.
4

. Inner places the border on the inside edge of the element.

Advanced

N

. Color sets the color of the border.

2. Join allows you to choose between Round, Bevel, and Miter joins. This influences the
joinsin a border such as a corner.

3. Position allows you to choose Outer, Center and Inner for the location of the border
on the edge of the element.

Size sets the thickness of the element border.

5. Opacity sets the transparency of the element border.

Shadow
. Shadow Style selects the pre-designed type of shadow to be used.
. Advanced Color changes the color of the text shadow.
. Angle sets the angle of the element shadow.

1
2
3
4. Offset controls the distance of the shadow from the element.
5. Blur allows you to blur the element shadow.

6

Opacity sets transparency of the element shadow

Reflection

1. Reflection Style sets the pre-designed style of reflection for the element.
2. Advanced Size modifies the size of the reflection.

3. Distance changes the distance between the element and its reflection.

4

. Opacity controls the transparency of the element reflection.
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TEXT
Inspector - El
ko Text Attributes
Presentation Margins
Slide left. 113 & Top 10 =
Background Right 13 [5 Bottom 10 -
Audic
Transition S
Vertical Align | Center -
Element
Fill Auto Sizing
Border i1 Do not auto size text
shadow @ Resize text to fit element
Reflection [¥] Nermalize text size across slides
y
Font Formatting
Outline [¥] Word Wrapping
Shadow [] Capitalize all words
Bullets [ Capitalize first word of each line
Media
Text Attributes

1. Margins: Left, Right, Top & Bottom margin settings

Back to Top

2. Text Layout: Vertical Alignment allows you to change the vertical alignment of the

text.

3. Auto Sizing: Do not auto size text turns auto-sizing off. Resize text to fit element
turns auto-sizing on. Normalize text size across slides: check this box if you want

EasyWorship to automatically make text on all slides the same size.

4. Formatting: Word wrapping turns automatic word wrapping on/off. Capitalize all
words automatically makes all words appear in all caps. Capitalize first word of each
line automatically capitalizes the first character of each line.
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Font

© N o g bk~ w0 Dd =

Font Name allows you to select a font style from the dropdown.
Size sets the font point size.

Color changes the color of the text.

Style allows you to select Regular, Bold, Italic or Bold Italic.
Underline turns underline on or off.

Superscript turns superscript on or off.

Subscript turns Subscript on or off.

Opacity sets transparency of the text.

Alignment

Text Alignment allows you to set the horizontal alignment of the text.

Outline

1.
2.
3.

Outline turns text outline on or off.
Color changes the color of the text outline.

Join allows you to choose between Round, Bevel, and Miter joins. This influences the
joinsin an outline such as a corner.

Position allows you to choose Outer, Center and Inner for the location of the outline
on the edge of the text.

5. Size sets the thickness of the text outline.

6.

Opacity sets transparency of the text outline.

Shadow

S T

Shadow turns text shadow on or off.

Color changes the color of the text shadow.

Angle sets the angle of the text shadow.

Offset controls the distance of the shadow from the text.
Blur allows you to blur the text shadow.

Opacity sets transparency of the text shadow.
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Bullets

1. Indent Level sets the indent for bullets.

2. Bullets selects between Bullets or Numbers and reveals options for selecting the bul-
let or number style.

MEDIA

Inspector - ]

Info Media Attributes

Presentation
Mame Tulips

Slide

Media Type IMcwie or Picture v]
Background

Ribiis Aspect Ratic | Auto vl

Transition

Element Mute
Fill Opacity B w0 [
Border
Shadow

Reflection

Text
Font

Cutline
Shadow
Bullets

1. Name: The name of the media element selected.
2. Media Type changes how the background image behaves.

Motion/Still Background stretches the image or video to fit the screen and if the
background is a video, it loops.

4. Movie or Picture does not stretch the video or image and does not loop if the back-
ground is a video.

5. Aspect Ratio sets the aspect ratio of the background.

6. Volume changes the volume of the media item being used as the background.

7. Mute: M runm he volume of the media item bein karound.
8. Opacity sets the transparency of the_%c_kground media item.

9. Apply To Theme button applies changes made in the inspector to the theme being
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10. Revert to Theme button reverts changes made in the inspector back to the default
theme settings.

10. Revert to Theme button reverts changes made in the inspector back to the default
theme settings.

Back to Top

-42-



EasyWorship 6 Manual: Options

OPTIONS

In This Article:

Live
> Song

> Scripture
> Presentation

Foldback

Advanced

N o gk w N =

Transitions

To access the Options menu in EasyWorship, click Edit in the main menu, then click
Options.

B EasyWorship
File Live Profiles Help
_ o= e T
utpu
» Options 3 | O |
s Live Options
2 Song Select Output Monitor
I ’ Scripture Output Monitor Output Position
Presentation Left 0 o
Alpha Channel Disabled hd b =
B Foldback Tep 0 F
Song Width 1024 |3
Scripture Height 768 .:.
Miscellaneous
Advanced
Screen Margi
Transitions B — e
Left 0 = Top 0 =
Right 0 51 Bottom 0 B
Auto Sizing
vorss 1 T
<ong text line one Maximum font pointsize 46 5
song text line two
song text line three
song text line four e Lo
SR——
[ Songs | Scriptures  Media  Presentations  Themes (=
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LIVE

Select Output Monitor

This is where you can setup how and where EasyWorship sends its output to the audi-
ence.

1.

Output Monitor : This dropdown button allows you to set the screen or location you
wish to send the EasyWorship output to.

Output Format: Allows you to select the format you wish to send to the NewTek
Tricaster over your local network connection. This option is only available when select-
ing the NewTek AirSend option from the Output Monitor dropdown.

Output Position: Shows you where EasyWorship is sending its output to by pixel loc-
ation. If custom position is select from the Output Monitor drop down, you will enter the
location you want EasyWorship to send its output to in these fields.

Alpha Channel: This dropdown button allows you to select which output to send alpha
channel content to. This option is not available if you have selected the NewTek
AirSend output from the Output Monitor dropdown.

Monitor Setup Button: Opens the Windows Display Settings window to allow you to
extend your windows Desktop to another screen or change other display settings
without having to close EasyWorship.

Screen Margins

This area allows you to customize the screen margins, i.e., fine-tuning the placement of
EasyWorship content on the output screen.

1. Left: Left margin setting.
2. Right: Right margin setting.
3. Top: Top margin setting.
4. Bottom: Bottom margin setting.
Back to Top
SONG

This area of the Options menu allows you to change the default settings for songs, i.e., the
look and feel of song text and margins being displayed to your audience.
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Song Font Button

1.

Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin set-
tings.
Formatting Tab: This tab allows you to customize song text formatting.
» Auto Sizing - select "Do not auto size text" if you want to turn auto siz-
ing off, or select "Resize text to fit element" to turn auto sizing on

(check the box next to "Normalize text size across slides" if you want
EasyWorship to automatically make text on all slides the same size).

» Word Wrapping - check this box to turn automatic word wrapping on.

» Capitalize all words - check this box to automatically make all words
appear in call caps.

» Capitalize first word of each line - check this box to automatically cap-
italize the first word of each line in a song.

Label Font Button

To the left of the Label Font Button is a checkbox that says Show Verse/Chorus Label.
Checking this box tells EasyWorship to display labels that have been entered into your
song, e.g., Verse, Chorus, Bridge, etc.

1.

3.

Font Tab: this tab allows you to select the default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off , and set the Opacity (trans-
parency) and alignment of the text.

Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
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and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Copyright Info Button

To the left of the Copyright Info Button is a checkbox that says Display Copyright
Information. Checking this box tells EasyWorship to display Copyright info on song
slides when displaying to the audience.

1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin set-
tings.

The License Info field allows you to enter your CCLI or other copyright license number to
be displayed on songs that require copyright information to be displayed.

SCRIPTURE

This area of the Options menu allows you to enable/disable support for displaying scrip-
tures (turns EasyWorship's Scripture tab on/off) and customize the default settings for
scriptures, i.e., the look and feel of scripture text and margins being displayed to your audi-
ence.

At the top of the Scripture Attributes area is a checkbox that says Enable support for
displaying scriptures. Checking this box tells EasyWorship to enable support for dis-
playing scriptures (turns EasyWorship's Scripture tab on).
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Scripture Font Button

1.

Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin set-
tings.

Back to Top

Verse Font Button

To the left of the Verse Font Button is a checkbox that says Show verse numbers.
Checking this box tells EasyWorship to enable verse numbering in the scripture text.

1.

Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Reference Font

To the left of the Reference Font Button is a checkbox that says Show Reference. Check-
ing this box tells EasyWorship to show the scripture reference on the output screen.

1.

Font Tab: This tab allows you to select a default font style and size, change the color

2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text

3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
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and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Other Reference & Scripture Options

1. Reference Location allows you to place the scripture reference Before Each Slide,
After Each Slide or After Each Passage

2. Show Complete Passage: when this box is checked, the complete scripture passage
reference will be visible on every slide instead of showing the reference for only the
passages on the current slide being displayed

3. Reference Indent. when this box is checked, EasyWorship indents the scripture ref-
erence.

4. Abbreviated Book Names: when this box is checked, EasyWorship will abbreviate the
book name in the scripture reference when this option is checked.

5. Break on new verse: when this box is check, this option tells EasyWorship to create a
new slide for every verse.

6. Minimum font size before breaking slide: this option allows you to set a limit on how
small the text in a scripture slide can appear before creating a new slide.

PRESENTATION

This area of the Options menu allows you to customize the default fonts for the Title, Sub-
title, and Content slides in your Presentations, i.e., the default look and feel for fonts in the
Presentation slides you create under the Presentations Tab in EasyWorship.
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Title Font Button

1.

Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin set-
tings.
Formatting Tab: This tab allows you to customize song text formatting.
» Auto Sizing - select "Do not auto size text" if you want to turn auto siz-
ing off, or select "Resize text to fit element" to turn auto sizing on

(check the box next to "Normalize text size across slides" if you want
EasyWorship to automatically make text on all slides the same size).

» Word Wrapping - check this box to turn automatic word wrapping on.

» Capitalize all words - check this box to automatically make all words
appear in call caps.

» Capitalize first word of each line - check this box to automatically cap-
italize the first word of each line in a song.

» Automatically capitalize the first character of these words - check this
box to automatically capitalize the first character of the words listed
below when they are used in a title slide.
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Content Font Button

1.

Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin set-
tings.
Formatting Tab: This tab allows you to customize song text formatting.

» Auto Sizing - select "Do not auto size text" if you want to turn auto siz-
ing off, or select "Resize text to fit element" to turn auto sizing on
(check the box next to "Normalize text size across slides" if you want
EasyWorship to automatically make text on all slides the same size).

» Word Wrapping - check this box to turn automatic word wrapping on.

» Capitalize all words - check this box to automatically make all words
appear in call caps.

» Capitalize first word of each line - check this box to automatically cap-
italize the first word of each line in a song.

» Automatically capitalize the first character of these words - check this
box to automatically capitalize the first character of the words listed
below when they are used in a title slide.

Back to Top

FOLDBACK

At the top of the Foldback Options area is a checkbox that says Enable support for dis-
play Foldback (stage display). Checking this box allows EasyWorship to take advant-
age of a third video output to display content for stage monitors.
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Select Output Monitor

Here you'll find all of the settings needed to setup how and where EasyWorship sends its
output to the display foldback.

1. Output Monitor: This dropdown allows you to set the screen or location to which the
EasyWorship output foldback content will be sent.

2. Custom Position: These fields show you where EasyWorship is sending its foldback
content to by pixel location. If custom position is selected from the Output Monitor drop
down, this is where you will enter the location you want EasyWorship to send its out-
put to.

3. Screen Margins: These fields allow you to fine-tune the Left, Right, Top, and Bottom
screen margins so EasyWorship's content displays properly on the foldback screen.

SONG

The Song Attributes window allows you to change the default settings for songs, i.e., the
look and feel of song text and margins being displayed to your audience.
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Song Font Button

1.

Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin set-
tings.
Formatting Tab: This tab allows you to customize song text formatting.
» Auto Sizing - select "Do not auto size text" if you want to turn auto siz-
ing off, or select "Resize text to fit element" to turn auto sizing on

(check the box next to "Normalize text size across slides" if you want
EasyWorship to automatically make text on all slides the same size).

» Word Wrapping - check this box to turn automatic word wrapping on.

» Capitalize all words - check this box to automatically make all words
appear in call caps.

» Capitalize first word of each line - check this box to automatically cap-
italize the first word of each line in a song.

» Automatically capitalize the first character of these words - check this
box to automatically capitalize the first character of the words listed
below when they are used in a title slide.

Label Font Button

To the left of the Label Font Button is a checkbox that says Show Verse/Chorus Label.
Checking this box tells EasyWorship to display labels that have been entered into your
song, e.g., Verse, Chorus, Bridge, etc.

1.

Font Tab: this tab allows you to select the default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off , and set the Opacity (trans-
parency) and alignment of the text.

2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text

Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
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and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

SCRIPTURE

The Scripture Attributes window allows you to enable/disable support for displaying scrip-
tures (turns EasyWorship's Scripture tab on/off) and customize the default settings for
scriptures, i.e., the look and feel of scripture text and margins being displayed to your audi-
ence.

At the top of the Scripture Attributes area is a checkbox that says Enable support for
displaying scriptures. Checking this box tells EasyWorship to enable support for dis-
playing scriptures (turns EasyWorship's Scripture tab on).

Scripture Font Button

1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin set-
tings.

Back to Top

Verse Font Button

To the left of the Verse Font Button is a checkbox that says Show verse numbers.
Checking this box tells EasyWorship to enable verse numbering in the scripture text.

1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text

3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
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and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Reference Font

To the left of the Reference Font Button is a checkbox that says Show Reference. Check-
ing this box tells EasyWorship to show the scripture reference on the output screen.

1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Other Reference & Scripture Options

1. Reference Location allows you to place the scripture reference Before Each Slide,
After Each Slide or After Each Passage

2. Reference Indent. when this box is checked, EasyWorship indents the scripture ref-
erence.

MISCELLANEOUS

The Miscellaneous Options area allows you to enable/disable and customize Next Item
Information, i.e., an abbreviated preview on the bottom of the display Foldback monitor
of what's coming up on the next slide.

To the left of the Next Item Font button is a checkbox that says Enable next item info.
Checking this box enables Next Item Information. Next item info can show up either 1)
as the first line of the next slide, or 2) as the title of the next item in the schedule.
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Next Item Info Button

1.

Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity (trans-
parency) of the text, and set the horizontal and vertical alignment of the text.

Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.

Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin set-
tings.

ADVANCED

Live Options

1.

Show live screen on startup: When checked, this options tells EasyWorship to display
the last used background on the output screen immediately after the program has
launched.

Advance Schedule after Go Live is pressed: When this box is checked, EasyWorship
automatically selects the next item in the scheduled when the Go Live button is
clicked. For example, the first item in your schedule is a mini-movie and the second
item is a song. When you select the first item and click Go Live, the mini-movie plays
and the song is automatically selected and ready to Go Live as soon as the mini-movie
ends. All you need to do is click Go Live again to send the song to the audience.

PowerPoint Options

1.

Use PowerPoint Viewer instead of Full PowerPoint Application: When this box is
checked,EasyWorship will load the PowerPoint Viewer to display PowerPoint slide
shows.

PLEASE NOTE: USING THE VIEWER IS AN UNSUPPORTED FEATURE AND
MAY RESULT IN EMPTY POWERPOINT THUMBNAILS ON SOME VIDEO
CARDS.
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DVD Options

1. Use preferred DVD video codecs: When this box is checked, EasyWorship will look
for and use DScaler if it is available (EasyWorship ignores other decoders if the
DScaler codec is available).

2. Prevent DVD spin down: When checked, this keeps the DVD in the drive spinning at
all times to reduce the amount of time needed to send a DVD clip to the screen.

Video Card Options

1. Disable GPU Shrink Filter: Only select this if you are only seeing a solid color on the
output screen. This option should only be used to troubleshoot rendering issues with
your video card.

TRANSITIONS

This area allows you to determine the default styles for slide to slide transitions, as well as
Black, Clear, and Logo transitions (Black, Clear, and Logo buttons are on the right side of
EasyWorship's main toolbar).

1. Slide Transition: Sets the transition between schedule items and between slides in a
song, scripture or presentation.

2. Black Transition: Sets the transition for the Black and un-Black transition.
3. Clear Transition: Sets the transition for the Clear and un-Clear transition.

4. Logo Transition: Sets the transition for the Logo and un-Logo transition.

Transition Options

Each transition selector has options that allow you to change the transition and how it
behaves. See the transition options below.

1. Transition: The transition dropdown allows you to select the transition you wish to use
for the slide.

2. Duration: Sets the length of the transition from start to finish.

3. Ease In/Ease Out: Controls whether the transition starts out fast and slows down or
starts out slow and goes fast. If the slider is all the way to the left, it will start slow and
end fast. If the slider is all the way to the right, it will start the transition fast and end
slow.

4. Lock Background when possible: If the background is locked, the text will transition
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over the background and the background will not transition with the text. When it is not
locked, the background will transition when the text transitions. This is most evident
when using the push or wipe transitions.

PREVIEW OUTPUT

In the bottom let corner of the Options window, there is a checkbox next to Preview Out-
put. Use this option to view changes on the output screen as you make them.

Back to Top
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PROFILES

In This Article:

Understanding Profiles

Create a New Profile

Create a Shared Database

Change Profiles
Edit a Profile

Locate Your Profile Data
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UNDERSTANDING PROFILES

Profiles consist of both User Settings and Application data. Application Data consists of
databases such as songs and backgrounds, along with videos, images, feeds and DVD
clips. User Settings consist of settings like font size, color and transition settings, as well
as information about the EasyWorship window size and location. Settings like the output
monitor setting are global settings that will affect all users and are not part of Profile set-
tings.

What is the benefit of Profiles? With a little bit of up front effort, Profiles let you store data-
bases in different locations and then associate multiple unique user settings to that applic-
ation data. Stated more simply, if Bob runs EasyWorship for the adults and Jennifer runs
EasyWorship for the youth group, they can both have access to the same resources
(songs, backgrounds, videos, etc), but have completely different user settings so
EasyWorship looks, acts and displays the way that fits their unique audience. Or, Bob and
Jennifer can create completely separate databases for their resources.

NOTE: The profile data can be stored on the local hard drive, on a server or shared network

folder. EasyWorship will create a Default profile in the following location. C:\User-
s\Public\Public Documents\Softouch\EasyWorship.
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Possible Profile Configurations

1. Use the same set of application data as another profile but different user settings.
(Example: Bob and Jennifer share the same resources [songs, backgrounds, videos]
but have different user settings so that Bob's slides are appropriate for the adults and
Jennifer's slides are appropriate for the youth.)

2. Use adifferent set of application data with the same user settings as another profile.
(Example: Bob and Jennifer have separate databases, so they don't mix resources
[songs, backgrounds, videos] but they have identical user settings.)

3. Use adifferent set of application data and a different set of user settings. (Example:
Bob and Jennifer have separate databases, so they don't mix resources [songs, back-
grounds, videos] and they also have different user settings.)

NOTE: EasyWorship also allows for easy hot swapping between Profiles. This means that

EasyWorship doesn't have to be closed when switching from one Profile to another.

Back to Top

The Profiles Menu

When you click Profiles in EasyWorship's main menu, you'll notice multiple options. At the
top are the names of all available Profiles that have been created ( "Default" is listed as the
only available Profile until additional Profiles have been created). To change Profiles,
select the profile you want to switch to.

1. Profiles Manager allows you to edit and create profiles in EasyWorship.

2. Database Tools has a Rebuild/Fix Database option. This checks the database for
errors and fixes them.

CREATE ANEW PROFILE

EasyWorship will create a default profile automatically when it is installed. If another set of
data or settings is desired, creating a new profile can accommodate this need.

Open EasyWorship

Click on the Profiles menu.

Click on Profiles Manager.

The Profiles Editor screen appears.

o r w0 N =

Click on either the + (Add) button or the New button to bring up the Add Profile

6. Under the General tab highlight the words New Profile and then either press the
7. ATer you type in the name that you want to Use, you can Click the OK pution to create
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8. Once you have created the new Profile, you can click the Close button or create
another Profile or edit an existing Profile.

8. Once you have created the new Profile, you can click the Close button or create
another Profile or edit an existing Profile.

NOTE: The default path location for Windows Vista, 7 and 8 it will be located in C:\User-

s\Public\Public Documents\Softouch\EasyWorship

Create a Shared Database

Open EasyWorship

Click on the Profiles menu.

Click on Profiles Manager.

The Profiles Editor screen appears.

Click on either the + (Add) button or the New button to bring up the Add Profile
menu.

o M v N =

6. Under the General tab highlight the words New Profile and then either press the
backspace or delete key then type the name that you want to use for the shared data.
(e.g., Shared, Network, etc.)

7. Clickthe Advanced tab.

8. Change the Type to Existing.

9. Click the Browse button.
10. This will open the "Browse for Folder" window.
11. Click Browse to locate the shared profile folder.

12. For network databases, browse to Network Computer Name (e.g. WorshipPC)\
Users\Public\Public Documents\Softouch\EasyWorship\

13. Select the profile folder (e.g. Default).

14. Under Options, click in the open field and type in the name you want to use for this
profile's options, or select a name from the drop down list.

15. Click OK.

NOTE: If you want to return to the Profiles Manager after creating the new profile, uncheck

the option for "Start Using this profile when complete."

Back to Top
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CHANGE PROFILES

EasyWorship allows you to change profiles easily, giving you the ability to use different
databases and settings without closing the application.

1. Click on Profiles in EasyWorship's main menu.
2. Select the Profile you want to use.

3. EasyWorship will load that profile. If you have a Schedule open, EasyWorship will ask
you to close it before loading the selected profile.

NOTE: Determining which profile is currently loaded is also easy. The current profile is the

one with a black dot on it when you click on the Profiles menu.

EDIT APROFILE

To change the settings or folder location of a profile:

Open EasyWorship

Click on the Profiles Menu.
Select Profiles Manager.
Select the profile to be edited.
Click the Edit button.

The Profile Editor window appears.

N o g bk~ 0w N =

On the left you will have the list of your currant profiles (Example: Default). On the
right you will have the Profile Name, the location of the Profile Instance and then
Options name.

8. Select the profile that you want and click the Edit button.
9. You will see the General and Advanced tab.

10. Click the Advanced tab from here you can change the Type of profile from Existing
to New, specify where the profile is located and change the Options that are asso-
ciated with the profile.

LOCATE YOUR PROFILE DATA

You may eventually need to transfer your database from one computer to another or copy
videos or images into the Resources folder. To find the location of the data for your Profile,
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use the following steps:

Open EasyWorship.

Click on Profiles in the main menu.
Click on Profiles Manager.

Select the Profile.

o M N =

Click on the link next to "Instance Location.” This will open the folder where your
Default folder and your Resources folder are located.

6. Or, you can use Computer or Windows Explorer to browse to the "Instance Location"
on your hard drive to find your data files.

NOTE: The databases will be stored in a Databases folder in a folder called Data.
Videos and Images will be stored in the Resources folder. Options for the profile will be

stored in the Options folder.
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SCRIPTURES

Add a Scripture to the Schedule
Quick Search

Adding Consecutive Scriptures

Scripture Reflow
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Using Scripture on the Fly

In this article, you'll learn how to add, edit and delete Scriptures in your EasyWorship
Schedule. You'll also learn about Search functions that are new to EasyWorship, making
it easier than ever to find, customize and present Scriptures to your audience.

ADD A SCRIPTURE TO THE SCHEDULE

1. Click onthe Scriptures tab in the Resource Area.

2. Selecta version of the Bible from the Resource Library on the left.

3. Tosearch the Scriptures by reference, click on the icon in the Search field above the
Resource Area. When it looks like a line list (=, it's set to search by reference.

4. Type your reference in the search box above the Resource Area.

5. Drag-and-drop the selected scripture to the Schedule Area.

6. To search the Scriptures by keyword, click on the icon in the Search field above the
Resource Area. When it looks like a magnifying glass (& , it's set to contextual

search (i.e., keyword).
7. Typeinany word or phrase to find what you're looking for.

8. Drag-and-drop the selected scripture to the Schedule Area.
Quick Search

» For a reference search such as 1 Thessalonians 1:3:

1. Inthe search box, type "1 The". EasyWorship will then auto-complete the book name
for you as 1 Thessalonians.

2. Pressthe Spacebar, then type in the chapter, 1

3. Pressthe Spacebar, then type in the verse, 3
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Contextual Search

” For a contextual search, like the word "hope":

Songs = Scriptures | Media  Presentations Themes (&, hope j +
SCRIPTURES Trans.. Reference Scripture
i asv KIv Ruth1:12 Turn again, my daughters, go [your wayl; forI am too =
& eee old to have an husband. If I should say, I have hope, [if]1 | = |
h,l HCSB should have an husband alse to night, and should alse £
_.!-_!.*..5.,'}'7 J bear sons;

1. Tosearch the Scriptures by keyword, click on the icon in the Search field above the
Resource Area. When it looks like a magnifying glass (&, it's set to contextual

search (i.e., keyword).
2. Type inthe word hope.

3. Every verse in the bible with the word "hope" will be listed.
Adding Consecutive Scriptures

»? For consecutive verses:

Songs | Scriptures | Media  Presentations  Themes (= John1:1-15 J K.
SCRIFTURES | Trans... Reference Seripture

& asv KV John1:d In the beginning was the Word, and the Word was with =

&l Bee God, and the Word was God.

gl Hess KW John1:2 The same was in the beginning with God.

H KV KV John1:3 All things were made by him; and without him was not

=il

1. You may like to add consecutive verses to the schedule at one time, such as John 1:1-
15.

2. Underthe Scriptures Tab in the Resource Area, select the version of the Bible you
would like to use from the Resource Library on the left.

3. Tosearch the Scriptures by reference, click on the icon in the Search field above the
Resource Area. When itlooks like aline list (=, it's set to search by reference.

4. Type your scripture range in the Search field (e.g., John 1:1-15). The scriptures are
automatically highlighted below in the Resource List.

5. Drag-and-drop the selected block of verses to the Schedule Area.

6. You may also type a single scripture in the Search field (e.g., John 1:1), then click on
the first verse, hold down the Shift key on the keyboard, click on the last verse in the
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By default, EasyWorship will reflow the text to a new slide when the maximum text
area isfilled.

By default, EasyWorship will reflow the text to a new slide when the maximum text
area isfilled.

Adding Multiple Non-Consecutive Verses

1.

You may want to use multiple non-consecutive scriptures such as Genesis 1:1,5,7, 8
and 12.

Under the Scriptures Tab in the Resource Area, select the version of the Bible you
would like to use from the Resource Library on the left.

Search for and click on your desired scripture (e.g., Genesis 1:1), then hold down the
Ctrl key on the keyboard and click each verse you want to display.

Drag-and-drop the selected verses to the Schedule Area.

5. EasyWorship will separate each verse into its own slide.

Scripture Reflow

Here's how to change the default Scripture Reflow setting so EasyWorship will create a
new slide for each verse.

o M w0 N =

Click on the Edit menu in the main toolbar.
Click Options.

Under Live, select Scripture.

Check the option to Break on new verse.
Click OK.

Back to Top

USING SCRIPTURE ON THE FLY

Single Verse

1. Click onthe Scriptures tab in the Resource Area.

2. Select the Bible version you want to use from the Resource Library on the left.
3.
4

. Double-click the selected scripture to make it Go Live.

Type the scripture reference in the Search field above the Resource Area.
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Multiple Verses

1. Click onthe Scriptures tab in the Resource Area.

2. Select the Bible version you want to use from the Resource Library on the left.
3.
4

. Hold down the Shift key on the keyboard, then use your mouse to click consecutive

Type the scripture reference in the Search field above the Resource Area.

verses, OR hold down the Ctrl key on the keyboard and use your mouse to click mul-
tiple non-consecutive verses. Once the verses have been highlighted, click the Play
button next to the Search field to make your selection Go Live.

Editing Scriptures

1. Drag-and-drop a scripture to the Schedule Area.
2. Right-click on the scripture in the Schedule.

3.
4

. Inthe Schedule Editor, make any needed changes (editing scripture is the same pro-

Click on Edit Item.

cess as editing a song in the Schedule). For more information on formatting scripture
text, see "Edit a Song in the Schedule" in Songs.

Back to Top
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SONGS

In This Article:

Add a Song
Type a Song

Edit a Song
Delete a Song

Customize Song Slides

Import a Song or Text

N o gk w N =

Locate and Display a Song

In this article, you'll learn how to add, edit and delete songs in EasyWorship, how to cus-
tomize song slides (backgrounds, custom labels, additional text fields), how to import
songs from Song Select Lyric Service or an existing EasyWorship database, and how to
locate and display a song to the audience.

ADD A SONG

The EasyWorship New Song dialog box allows you to add a new song to the songs
resource area database by typing it, by importing it or by copy and paste.

1. Click the + icon button at the bottom of the song list, or right-click any song under the
Songs tab in the Resource Area, and select New Song.

2. The Song Editor dialog box appears.

TYPE ASONG

1. Type a name for the song in the Title box.

2. Type the label you want to use for the slide under the Words tab. (e.g. Verse 1,
Chorus, Intro)

3. Type the lyrics for the song in the Words tab.

4. To create a new slide, either press Ctrl+Enter after typing the slide text or click the
Add icon at the bottom left corner of the Words tab.
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EDIT ASONG

The EasyWorship Editor allows you to edit songs, miscellaneous text, and song inform-
ation. When editing a song, you can choose either to save your edits to the song in the cur-
rent schedule only, or to save your edits to the song permanently in the song Resource
Area.

Edit a Song in the Schedule

8.
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In the Schedule area, select the song to be edited.

Right-click on the song.

Click on Edit Item from the pop out menu.

The Schedule Editor window appears.

The Words tab or Slides tab can be used to enter or edit text as needed.

Use the toolbar to change the font and size of the text, the style, and the alignment.

Use the header buttons to select a Theme, create a new Text box, add a Scripture
or Media element or Background, or Arrange Elements (See Customize Song

Slides).

Use the Inspector button to customize your song any way you want.

Edit a Song in the Database

N o gk w N =

8.

In the Resource Area, click on the Songs tab.

Select the song you wish to edit.

Right-click on the song.

Click on Edit Song from the pop out menu.

The Words tab or Slides tab can be used to enter or edit text as needed.

Use the toolbar to change the font and size of the text, the style, and the alignment.

Use the header buttons to select a Theme, create a new Text box, add a Scripture
or Media element or Background, or Arrange Elements.

Use the Inspector button to customize your song any way you want.

Edit Song Copyright Information

The CCLI# appears by default when a song is copyrighted, or you can add the copyright
symbol and date to the Inspector in the Song Editor. Once you have entered the CCLI #, it
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will automatically appear in each copyrighted song. To add/edit the CCLI #, follow these
steps:

1. Click on the Songs tab in the Resource Area.
2. Right-click on the song and select the option to Edit Song.

3. Click the Inspector button in the top-right corner of the Song Editor window to display
the Song Information.

4. Edit the desired information and close the Inspector window.

5. Inthe Song Editor, click OK to save your changes.

DELETE A SONG

Remove a Song from the Schedule

1. Inthe Schedule area, locate the song you would like to remove.

2. Right click on that song and select Remove From Schedule from the pop out menu.
3. You will get a confirmation asking if you’re sure you want to delete this schedule item.
4

. Click Yes to remove this song from the schedule.
Delete a Song from the Database

WARNING: The following procedure permanently deletes the selected song from the
EasyWorship Songs database.

1. Inthe Resource Area, locate the song you would like to delete.
2. Right-click on that song and select Delete from the pop out menu.

3. You will get a confirmation asking if you're sure you want to permanently delete this
song.
4. Click Yes to permanently delete the song from the songs database.

Back to Top

CUSTOMIZE SONG SLIDES

You can also select a Theme, create a text box, add Scripture or Media, and use the
Arrange and Inspector buttons on the toolbar to format your new song.
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Select a Theme

Click the Theme button on the toolbar and select the desired Theme you would like to
use for that song.

Add Another Text Box
Click the Text button on the toolbar to add another text box to the current slide.
Add a New Slide

Click the + icon in the bottom left corner to create a new slide, and then type the new slide
text.

Splitting Slides

If you need to split an existing slide into two or more slides, move the cursor to the begin-
ning of the line you wish to be the first line of the new slide and press Ctri+Enter on the
keyboard.

Insert Labels

1. When a new slide is added, there are two field options. One for Label and one for
Song

2. Click where it shows label and type in your label. i.e. Verse1 or Chorus
3. Then press Enter to type the new song text

4. Click OK when you are satisfied with the song

Add Scripture to Current Slide

1. Click the Scripture button on the toolbar.

2. Select the translation you would like to use.

3. Search for the scripture you would like to use.
4

. Either double-click the verse(s) or drag and drop the verse(s) to add the scripture to
the current slide.

5. The scripture will be added in its own text box that you can resize and move if needed.
Add Media

»” Add Media as a background for the whole song:
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Click the Inspector button on the toolbar.

Click Background.

Select your Fill Style.

For each respective style, choose all the options you want to use.

Click the Apply to Theme button at the bottom.

» Adding media as a background for a single slide:

. Click the Slides tab in the upper left of the song editor

Click the Media button on the toolbar

Select the type of media you want to use from the dropdown (Videos, Images, Feeds,
DVDs, Audio)

Drag and drop your desired media file from the Media dropdown to your desired slide
under the Slides tab on the left

»” Adding Media as an element to the current slide:

. Click the Slides tab in the upper left of the Song Editor.

Click the Media button on the toolbar.

Select the type of media you want to use from the dropdown (Videos, Images, Feeds,
DVDs, Audio).

Double-click your desired media file (you can also drag and drop the media file to the
selected slide directly below the Media tab).

5. Resize and move the element to your desired location on the slide.

You can select the element and arrange it to the front or back by clicking on the
Arrange button on the toolbar.

Click OK when you are satisfied with the song.

Back to Top
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IMPORT A SONG OR TEXT

Import a song from document

1. Open EasyWorship, Click the + icon at the bottom of the song list to create a new
song.

2. Click the Importicon to the left of the printer icon at the top of the editor. The Win-
dows Open dialog box appears allowing you to locate the desired file.

3. Click OK when you have located the file. The song or text appears in the text box
where you can edit and format it.

Import a song from SongSelect Lyric Service

CCLI's™ SongSelect Lyric Service allows you to download songs from thousands of
songs on their web site for a nominal monthly/yearly fee. This Lyric Service is provided by
Christian Copyright License International. To use the CCLI's™ SongSelect Lyric Service,
you must be a member with a valid User ID and Password. If you are not a current mem-
ber, you can subscribe to this service at ccli.com.

Click the Web button on the toolbar.
Click SongSelect tab at the top.

Sign in to your SongSelect account.
Search the song you would like to import.

Click to view the Lyrics page for that song.

I O

In the upper right corner, click the Import button and the song will be added to your
song database.

7. If youwant the song to be added to the Schedule from that page, click the Schedule
button at the top right.

8. To make any changes to the song, right-click the song in the database and select Edit
Song. (For help editing songs, go to Edit a Song.

9. Toclose out of the Web, click the Web button on the toolbar again or click the Close
button at the top right.

NOTE: You must be connected to the Internet to download a song from CCLI's™

SongSelect Lyric Service.
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Copy / Paste

1.
2.

Type a name for the song in the Title box.

Type the label you want to use for the slide under the Words tab. (i.e. Verse 1,
Chorus, Intro ...)

Paste in the text you copied from another source (Word, Notepad, website ...)

NOTE: If you have made changes to the attributes of the song and you want to change it
back to the default, click the Reset to Default button. If you delete or change the actual text,

you can use CTRL - Z to undo the changes.

Back to Top
LOCATE AND DISPLAY A SONG
1. Inthe Resource Area, click the Songs tab.
2. Type the name of the song in the search box for a Title search, or change to a Con-
textual search and search by keyword (e.g., popular phrase in the lyrics).
3. Begin typing and EasyWorship will auto-complete the text with the best match alpha-
betically.
4. After you locate the song, drag-and-drop it from the Resource Area to the Schedule

Area.

OR select the song in the database and click Go Live, or double-click the song to
send it directly to the Live Output Area.

Click on each verse in the Live Area and follow your leader, OR use the UP and
DOWN arrows to advance to the next slide.

NOTE: To change the background of a song on-the-fly, select the song and click Com-
pose in the Compose Window to the right. Then click the Media tab and double-click

the media item you want used as the background. Click the + (Add) button to add it
to the schedule or the > (Play) button toimmediately send it to the live screen.
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DISPLAY FOLDBACK (STAGE DISPLAY)

In this article:

What Is Display Foldback?

Hardware Options

Setup for NVIDIA GeForce or Secondary Graphics Card
Setup for the Matrox DualHead2Go

o M v N =

Matrox DualHead2Go Connection Examples

WHAT IS DISPLAY FOLDBACK?

Your audience is first, but your stage needs support, too. While the audience sees the
presentation on the main screens, Stage Display lets the stage see a custom display with
the current presentation or video, a preview of the next scheduled item, a clock and
private alerts. This goes for PowerPoint presentations as well. EasyWorship even lets the
stage see variable thumbnails for previous, current and next slide.

HARDWARE OPTIONS

If you want to take advantage of the Stage Display (Foldback) feature in EasyWorship,
you will need some basic hardware and a little patience to set everything up (but no wor-
ries, we'll help you, and everyone will thank you later!). This article will explain what you
need to get started along with step-by-step setup instructions. In order to use Display Fold-
back in EasyWorship, you will need one of the following hardware solutions (You can
order any one of these online from NewEgg.com or TigerDirect.com):

1. Matrox DualHead2Go
2. Second Video Card

3. NVIDIA GeForce GTX graphics card with surround technology (we recommend using
650/750 or 690/790 models)
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SETUP FOR NVIDIA GEFORCE OR SECONDARY GRAPHICS
CARD

We'll get into setup instructions for the Matrox DualHead2Go further down in this article,
but first let's look at setup for the NVIDIA GeForce GTX or a Secondary Graphics Card.

NOTE: You may also use another PCI Express X16 video card or a single NVIDIA GeForce
GTX graphics card to control the Front of House (what the audience sees) and Stage Display
(Foldback) screens. See the in our Knowledge Base.

This will help you to find the best video cards to use for Stage Display purposes.

Front of House Settings

1. In EasyWorship, click the Edit menu, then Options.

2. Under Live, click the Output Monitor dropdown, then select the monitor you wish
to use for the Front of House display. This is usually Monitor 2 (Secondary) from the
drop down list next to Output Monitor).

3. Click OK.

Foldback Settings

1. In EasyWorship, click the Edit menu, then Options.

2. Under Foldback, check the box to "Enable support for display Foldback (stage dis-
play)."

3. Under Select Output Monitor, select the monitor you wish to use for Display Fold-
back. This is usually Monitor 3 from the list next to Output Monitor.

4. Click OK.

SETUP FOR THE MATROX DUALHEAD2GO

When using a Matrox DualHead2Go box, the secondary output from your computer's
video card plugs into the input on the Matrox box. The Matrox box also has two outputs
that are spanned across two monitors/projectors/tv’s. The screen resolution for that out-
put is double-wide. If that sounds too technical, here are a couple examples that should
help you picture how it works.
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Example 1

Imagine you have two projectors. You know that one is for the audience and the other is
projecting onto the back wall for the stage to see, but Matrox just sees these as two out-
puts side-by-side. Now, if each projector has a resolution of 1024x768 (that's 1024 pixels
wide and 768 pixels tall), then together (side -by-side) the resolution will be 2048x768.
When you conncet the Matrox box to the two projectors, the combined resolution will be
2048x768. That's all the Matrox box needs to know. EasyWorship is the one that will com-
municate that to the Matrox box, as well as which graphics and words to send to the first
projector for the audience, and which graphics and words to send to the projector for the
stage. As long as you set EasyWorship up correctly, it will take care of telling the Matrox
box what to do.

Example 2

Here's another example using a simple diagram (below). Imagine two pieces of paper
next to each other where the left piece (piece 1) is what goes to your computer monitor
and the right piece (piece 2) represents what the Matrox box is sending to the two pro-
jector screens. Since the output resolution on piece 2 is double-wide, we can splititin the
middle and send the first half to the first projector for the audience and the second half to
the second projector for the stage to see.

1] 1 ¥ 4 ] ] ¥ 0 1 4‘
piece 1 piece 2
Manitor 1 Monitor 2 [Matrox DH2G)
[Cempuier Manidcs) Fromt of Mouss) (Faldback]
Back to Top

Finding Left Positions (sounds technical, but we'll make it easy)

To tell the Matrox box what it needs to make Display Foldback work, EasyWorship needs
to know the left position of the Front of House screen, the left position of the Display
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Foldback screen, and the width and height of both.

1.

Left Position for Front of House: To find the left position for the Front of House screen

(piece 2), we just need to know the width of Monitor 1 (piece 1). In the example above,
the width of piece 1 is 4. Piece 1 goes from 0 to 4, so piece 2 starts its left position at 4.
Not too bad.

Left Position for Display Foldback Screen: To find the left position of the Display
Fodlback screen (second half of piece 2), we need to know the distance from the left
side of piece 1 to the middle of piece 2. We will add the width of piece 1, which is 4, to
half the width of piece 2, which is 5 (or 4+5=9). So, in the example above, the left pos-
ition of the Display Foldback screen would be 9.

If you were using the numbers from the above diagram to set the custom positions in
EasyWorship, the left position for the Front of House screen would be 4, and the left pos-
ition for the Display Foldback screen would be 9. The width for each would be 5 since they
are both using half of the secondary monitor resolution (10/2=5). The height would be
whatever the height is from the resolution setting.

Now, let's look at how this simple illustration works with actual monitor resolutions.

Finding Width and Height of Both Monitors

Now, we can replace the numbers from the example above with the actual numbers from
the resolutions your monitors and projectors are using.

1.
2.
3.
4.

Right-click on the Windows desktop.
Vista users will select Personalize then click the Display Settings link.
Windows 7 and 8 users will select Screen Resolution.

Click each monitor to determine its resolution (width and height). The size will be dis-
played in the Resolution Area, e.g., 1024x768, 1920x1080, etc.

Example Screen Resolutions (below):

1.
2.

Monitor 1: 1024 pixels wide by 768 pixels high (1024x768)
Monitor 2: 2048 pixels wide by 768 pixels high (2048x768)

1024x768 2048x768
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IMPORTANT: These resolutions may be different on your computer. Write this information
down for use in the steps under Front of House Settings and Foldback Settings. If the

second monitor is not already set to a double wide resolution, change the change the res-
olution in the windows display settings to a double-wide resolution.

Back to Top
Common double-wide resolutions to use:

1. Standard 4:3 - 1600x600 or 2048x768
2. Widescreen 16:9 - 2560x720
3. Widescreen 16:10 - 2560x768

If one of these resolutions is not available, you may need to contact Matrox Technical
Support (www.matrox.com/graphics/en/support/).

Front of House Settings

1. In EasyWorship, click the Edit menu, then Options.
2. Under Live, click the Output Monitor dropdown, then select Custom Position.

3. In Output Position, set "Left" to the width of Monitor 1, set "Top" to 0, set "Width"
to half the width of Monitor 2, and set "Height" to the height of Monitor 2.

4. Click OK.

Using the example illustration below, your custom position settings in EasyWorship for
Front of House (Live Output Monitor) would be the following:

1. Left: Width of Monitor 1 = 1024

2. Top:0

3. Width: Width of Monitor 2 (2048) divided by 2 = 1024
4. Height: Height of Monitor 2 = 768

Primary  Front of House Foldback

1024x768  1024x768 1024x768
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NOTE: Your screen resolutions probably will not match the example above. To determine the

values needed to correctly set up EasyWorship for your situation, see Finding Left Pos-
itions and Finding Width and Height of Both Monitors instructions above.

Back to Top

Foldback Settings

1. In EasyWorship, click the Edit menu, then Options.

2. Under Foldback, check the box to "Enable support for display Foldback (stage dis-
play)."

3. Under Select Output Monitor, select the monitor you wish to use for Display Fold-
back. This is usually Monitor 3 from the list next to Output Monitor.

4. In Custom Position, set "Left" to the width of Monitor 1 + half the width of Monitor 2,
set"Top" to 0, set "Width" to half the width of Monitor 2, and set "Height" to the
height of Monitor 2.

5. Click OK.

Using the example illustration below, your custom position settings in EasyWorship for
Foldback would be the following:

1. Left: Width of Monitor 1 (1024) + half the width of Monitor 2 (1024) = 2048

2. Top:0

3. Width: Width of Monitor 2 (2048) divided by 2 = 1024

4. Height: Height of Monitor 2 = 768

Primary  Front of House Foldback

B

1024 + 1024 = 2048 Left
Position

NOTE: Your screen resolutions probably will not match the example above. To determine the

values needed to correctly set up EasyWorship for your situation, see Finding Left Pos-
itions and Finding Width and Height of Both Monitors instructions above.

Back to Top
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MATROX DUALHEAD2GO CONNECTION EXAMPLES

The Matrox DualHead2Go can support a maximum of two outputs: either two Front of
House outputs or one Front of House output and one Display Foldback output. If you need
a Display Foldback output as well as two Front of House outputs, you'll need to add a split-
ter to your setup. Here are two illustrations that show the Matrox DualHead2Go without a
splitter (for Display Foldback and one Front of House output) and with a splitter (providing
Display Foldback and two Front of House outputs).

Without a Splitter

Foldback

0
/N

oo

= O
Matrox ’/ "/ ||\"h
Front Of House

With a Splitter

Foldback

0O
/N
- O LN

Matrox Splitter (9] (@]
O E\Ee L LA

FOH 1 FOH 2

oon

In the diagram below, a switcher has been added to the configuration, allowing you to
show either the Foldback view on the Foldback screen or the Front of House view on the
Foldback screen.
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Back to Top
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VIDEOS

Adding Videos
Adding Videos from the Media Store in EasyWorship

Playing Videos

Deleting Videos

Using Videos in Presentations and Songs

I O

Video Properties Editor

EasyWorship allows you to use videos as an individual schedule item, as a background, or
as an element in a presentation. The following steps will show you how to add videos to
the EasyWorship media area and how to use them.

ADDING VIDEOS

EasyWorship can import videos that you have produced, or additional videos you have
purchased.

In the Resource Area

1. Click the Media tab.
2. Clickthe Videos tab.

3. Click the Add button at the bottom of the video resource list to access the Add
Videos dialog box.

4. Locate and highlight the video or videos that you want to import.
5. Click Open.

NOTE: You can drag-and-drop a video from Windows File Explorer or the desktop into the

videos Resource Area.

ADDING VIDEOS FROM THE MEDIA STORE IN EASYWORSHIP

1. Forinstalling Sample Media See: Installing Sample Media

2. For purchasing and downloading media See: Media Store Tab
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PLAYING VIDEOS
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In the Resource area, click the Media tab.

Select Videos from the Resource Library on the left.

Drag and drop a video to the Schedule Area.

Select that video in the schedule and click the Go Live button.

You may also select a video in the Resource Area and click Go Live.

DELETING VIDEOS

In the Resource Area

o M N~

Click the Media tab.

Right click the video that you want to delete.

Click Delete.

A message appears asking if you want to permanently delete the video.

Click Yes to delete the video.

Drag and Drop Features

. Add to Schedule: Drag and drop a video into the schedule from the Images tab.

Use as Background: Drag a video onto a song in the Schedule to assign that image to
a song as a background.

Add a New Video: Drag and Drop a video from any folder in Windows to the videos
area.

USING VIDEOS IN PRESENTATIONS AND SONGS

When creating or editing a presentation or song, you can access videos from the media
drop down. You can drag and drop videos on to slides as an element or drag it to a slide in
the Schedule Area to make it a background for that slide.
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In the Inspector

1. Click Background under Slide.
2. Change the Fill Style to Media Fill.

3. Clickthe dropdown next to Select Media to select the video you wish to use as the
background.

4. Click Apply to Theme to set the background for all slides.

Back to Top

VIDEO PROPERTIES EDITOR

Follow these steps to edit the properties of any video in EasyWorship:

1. Click on the Media tab in the Resource Area.

2. Select Videos from the Resource Library on the left.

3. Right-click on any video and select the option to Edit Video Properties.
4.

The Video Properties editor will appear, allowing you to customize properties of the
video such as volume, aspect ratio, Mark In and Mark Out points, etc.

Properties Tab

# Video Properties = l@l

| Video Properties
L}'J Edit properties for pgrm_green radiance 1080.50480

PROPERTIES | INFO

eTitIe bgm_green radiance 1080.50480 n

Clip Properties
o
00:00:15.02 [3

Aspect Ratio

(] 0y 0:15 Audio Properties
00 © 8% g :

ol R o) e— () 100 Ef OMute

[ 0K H Cancel ]
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1. Play / Pause: The play/pause button starts and stops the video playback.

2. Fast-Forward / Rewind: Single clicking skips forward or backward one chapter.
Holding the FFW or RWD buttons down will fast forward or rewind the video.

3. Continuous Play / Repeat: button allows you to loop the dvd clip you are viewing or
let it stop at the end of the clip.

4. Mute & Volume: button and volume slider only controls the audio while working with
the DVD clip. The audio will not be muted on playback.

5. Title : Type the name of the DVD clip in this field.

6. Thumbnail: Click the thumbnail box on the right to set the thumbnail. (This takes a
snapshot of what is currently in the player window)

7. Clip Properties: Start Position is the time at which the DVD clip will start. Use the up
and down arrows to manually adjust the time. Mark In sets the start position of the
DVD clip. Click this button as the DVD clips plays to set the start position. End Pos-
ition is the time at which the DVD clip will end. Use the up and down arrows to manu-
ally adjust the time. Mark Out sets the end position. Click this button as the DVD clips
plays to set the end position. Reset simply resets the Start and End Points.

8. Aspect Ratio: Allows you to maintain the aspect ratio, stretch or zoom the video.

9. Audio Properties: Allows you to change the volume of the DVD clip when you go
live with it. The volume slider allows you to set the volume of the DVD clip for playback
to the audience. Mute allows you to mute the audio on the DVD clip if you don’t wish to
use the audio portion of the DVD.
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Info Tab

B Video Properties

Video Properties
Edit properties for pgm_green radiance 1080.50480

PROPERTIES INFO
Title Opgm_green radiance 1080.5D480
Author e

Copyright e
6 Description

B

0:02 f 0:15

P o = o) C—

QK l ’ Cancel

A o bd =

o

Title: Enter the name of the video clip in this field.
Author: Enter the Author in this field.
Copyright: Enter copyright info in this field.

© Button: Pressing the copyright logo button adds the copyright logo to the copyright
field.

Description: This drop down allows you to enter a description for the video clip.

Tags: This drop down allows you to enter tags for the clip.

7. The OK button saves the video properties and closes the window.The Cancel but-

ton cancels all changes and closes the window without saving.

Back to Top
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PRESENTATIONS EDITOR

EasyWorship's robust Presentation Editor is a full slide designer. Choose from different
types of slides, control transitions, create slide loops, and create/apply custom themes.

When you edit a presentation in a Schedule, you can choose to make changes that affect
the presentation for that schedule only, or you can make permanent changes to a present-
ation in the Resource Area under the Presentations tab.

EDIT APRESENTATION IN THE SCHEDULE

In the Schedule Area, select the presentation to be edited.

Right-click on the presentation.

Click on Edit Item.

The Schedule Editor window appears.

The Words tab or Slides tab can be used to enter or edit text as needed.

Use the toolbar to change the font and edit its style, size, and alignment.

N o gk~ w N =

Use the heading buttons to select a Theme, create a new Text box, add a Scripture or
Media element or Background, or Arrange Elements.

8. Use the Inspector button to customize your presentation any way you want.
Add a new slide

1. Click the + (Add) icon in the bottom left corner to create a new slide, and then type
the new slide text.

2. Click OK when you are satisfied with the presentation.
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EDIT APRESENTATION IN THE DATABASE

N o gk~ w N =

In the Resource Area, click on the Presentations tab.

Select the presentation you wish to edit.

Right-click on the presentation.

Click on Edit Presentation.

The Words tab or Slides tab can be used to enter or edit text as needed.
Use the toolbar to change the font and edit its style, size, and alignment.

Use the heading buttons to select a Theme, create a new Text box, add a Scripture or
Media element or Background, or Arrange Elements.

Use the Inspector button to customize your presentation any way you want.

Back to Top
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THEMES

In this article:

1. Overview

2. Theme Editor

3. Creating A Theme
4

. Using Themes

OVERVIEW

Themes are simply design templates that can be applied to songs, scriptures, and present-
ations. How does this make your life easier? Once you've taken the time to design a
Theme by customizing your text format, background and layout just the way you want, it
can then be applied to any song, scripture or presentation in your Schedule Area in
seconds. Just save your new Theme to your Theme Library, then drag-and-drop it on top
of a song, scripture or presentation in your Schedule. You can also select and apply it
using the Theme button in any one of the Song, Scripture or Presentation Editors.

CREATING A THEME

It's quick and easy to build a theme in EasyWorship using the Theme Editor. To get star-
ted, click the Themes tab in the Resource Area, select the type of theme you want to cre-
ate (Song, Scripture, or Presentation), and then click the + (Add) button at the bottom of
the Themes Area. You may also create a theme by selecting one or more media items,
right clicking on the selected media item(s) and selecting copy to Song, Scripture or
Presentation Theme. This will place the media item in the themes area allowing you to use
it as the default theme (a.k.a. background) or drag and drop to a song in the schedule or
select it from the themes drop down in the song or presentation editor.

NOTE: The theme editor is similar to the Song and Presentation Editors in that it has slides,
an Inspector, and it allows you to add media and text boxes to slides. However, unlike the

Song and Presentation Editors, the Theme Editor does not allow you to add or change text on
the slides.The Theme Editor is designed for making overall formatting and placement
changes, not changes to the text or other content on the slides.
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THEME EDITOR
B Theme Editor - Untitled [= |
T B- . LB
=Y | Theme Text Scripture  Media Arrange | Inspector |
e r] 6+ +~ 3 1)) ¢ u (EYD)) = ()= | = (@)«

Master

song text line one
song text line two
song text line three

song text line four

Toolbar

1. Title: Enter the name of the theme in this field.
2. Text: Adds a text box that you can type text in to display on each slide.

3. Scripture: Clicking the scripture button allows you to select scripture text and press
enter or drag it to add it to the theme.

4. Media: Clicking the media button allows you to select videos, images, feeds, DVD
clips or audio and press enter or drag it to add it to the theme.

5. Arrange: Clicking this button allows you to set the layer at which the selected element
resides. You have the option of Move Up, Move Down, Bring to Front, Send to Back.

6. Inspector: Opens the inspector window. The Inspector allows you to make more
detailed formatting changes to different elements in the theme.

7. Import: Allows you to import a text document into your song, presentation or theme.
8. Print: Allows you to print the theme.

9. Spell Check: Checks spelling and allows you to make spelling changes or add words
to the dictionary.
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Buttons

1.

w

© ® N o g &

10.
11.
12.
13,
14.
15.
16.

17.
18.
19.

Font Selector: Clicking the font selector allows you to select the font formatting you
wish to use on selected text.

Font Size: Changes the font size of the text to the point size selected.

Font Color: Allows you to change the color of selected text by selecting from the
color palette provided.

Bold: Makes selected text bold.

Italics: Italicizes selected text.

Underline: Underlines selected text.

Shadow: Turns shadow on or off for selected text.

Outline: Turns outline on or off for selected text.

Left Align: Sets selected text alignment to left.

Center Align: Sets selected text alignment to center.

Right Align: Sets selected text alignment to right.

Top Align: Set selected text vertical alignment to top.
Middle Align: Set selected text vertical alignment to middle.
Bottom Align: Set selected text vertical alignment to bottom.
Reset to Default: Resets formatting to default settings.

Slides Area: Displays the slides available to modify and allows you to select which
slide you wish to modify.

Zoom Slider: Sets magnification of the current slide you are working on.
OK: Saves the Theme and closes the Theme Editor window.

Cancel: Closes the Theme Editor window without saving.

Master, Normal, and Overlay Slides

When creating a theme, you are presented with a Master Slide and various other slides
that represent the possible types of slides you might create in a song, scripture or present-
ation. When editing the master slide, certain formatting options are automatically dis-
played on the appropriate slides below. For example, changing the background on the
Master Slide will change the background on all slides below it. If you want to change
formatting for a specific slide, select that slide and make the formatting change you wish to
make.
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When creating a Song or Scripture Theme, the default slides will be the Master, Normal
and Overlay slides. The Normal slide is for normal song or scripture text formatting and
the Overlay is for lower thirds formatting.

USING THEMES

Presentation Themes

When you add a Presentation Theme, you'll notice that it has more default slides than a
Song or Scripture Theme. That's because a Presentation Theme has many different
types of content slides that can be added to it (e.g., Title Slide, Title and Content Slide,
Content Only Slide, Blank Slide, and Scripture Slide).

Theme Button

When editing a song, scripture or presentation, in the Editor's main toolbar you'll see a
Theme dropdown button. Click this button and select an existing theme to apply its lay-
out and formatting to the song, scripture or presentation you're working on. You may also
drag and drop a theme onto a song, scripture or presentation in the schedule from the
Themes Area.

B Schedule Editor - Genesis 1:1 (ASV) o |[=][=
Genesis Li1 (ASV) v T IE‘ . B Iﬂ . u
‘;6]' = ‘?Y Theme Text Scripture  Media Arrange Inspector
|Tah0ma v| 41 v AT A~ | Iv| I u @@| = @|

[ Words [Slides

1[4 Genesis 1:1 (ASV)
1 In the beginning God created the heavens and
the earth.

1In the beginning God created

the heavens and the earth.
Genesis 1:1 (ASV)

|+ | 2~ 30% {J =

| QK | | Cancel
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Back to Top
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ALPHA CHANNEL SETUP

In this article:

What Is Alpha Channel?

Before Getting Started

Enable Alpha Key in EasyWorship
Enable Windows Extended Desktop

Ao Dd -

WHAT IS ALPHA CHANNEL?

Alpha channel is basically a mask. It determines how an object's pixel colors are going to
blend with pixel colors from another object when the two are overlaid. In EasyWorship,
when placing text (e.g., lyrics) or a transparent PNG (e.g., church logo) on top of a motion
background or live feed, alpha channel is the best way to generate clean, professional
edges around the text--especially important for IMAG, live stream or HD broadcast.

EasyWorship's alpha channel support was designed for those who have a video mixer
that uses alpha key to overlay text and graphics on a video source. Alpha channel keying
provides the best quality for text and graphic overlays.

BEFORE GETTING STARTED

Alpha channel support requires a single NVIDIA Geforce GTX series graphics card that
can support at least three simultaneous video outputs. Before using the alpha channel
function in EasyWorship, make sure your computer meets the system requirements for
alpha channel support. Connect the alpha channel and EasyWorship Output to the video

mixer and extend the Windows desktop to each output (see Enable Windows Extended
Desktop below).

The following instructions show you how to set up EasyWorship. They will not help you
configure your video mixer. Please consult the support resources for your mixer for help
configuring an alpha key on the video mixer.
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ENABLE ALPHA KEY IN EASYWORSHIP

Open the EasyWorship program.

In the main menu at the top, select Edit.

From the dropdown, select Options. The Live Options window will appear.
Change the Output Monitor option to the output you wish to use.

Change the alpha channel option to the output you wish to use for the alpha channel.
Select OK.

S O A

NOTE: If all of the video outputs do not appear in the dropdown boxes make sure the desktop

is extended to all displays. See below.

Back to Top
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ENABLE WINDOWS EXTENDED DESKTOP

1. Open EasyWorship.

2. Select the Edit menu.

3. Select Options.

4. The Options dialog box appears.

» Options =3 =R
Live Live Options
Song Select Qutput Monitor

Seripture Qutput Menitor | Custom Position - TriprlrEsen
Presentation Left [i] &
Alpha Channel Disabled hd

Foldback Top O
Song Width 1024 £
Scripture

Height 768 =
Miscellaneous

Advanced

Screen Margins

Transitions < =
Left 0 = Top 0 =
Right 0 3 Bettem O <
Auto Sizing
verse 1 —
=ong text line one Maximum font point size 46 =

song textline two

song text line three
song text line four

£ Prsin ot

5. Select the Live tab on the upper left.
6. Inthe section titled Live Options, select the Monitor Setup button.

7. EasyWorship will open the Screen Resolution dialog box.

[E=% ECR =58

{ H pv|!J <« Displ.. » Screen .. vl‘f” Searc

Change the appearance of your displays

Display: 2. SyncMaster «

Reszolution: 1024 = 768 (recommended)

Multiple displays: IShow desktop only on 1 V]

Make this my main display Advanced settings

Make text and other items larger or smaller

What display settings should I choose?

oK || Cancel Apply 96 -
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NOTE: If there is only one monitor in the Screen Resolution window or you are unable

to extend the desktop to monitor, your video card may not support more multiple dis-
plays, or all video outputs may not be connected to a display.
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IMAGES

In this article:

Display Images

Add New Images
Right-Click Features
Drag & Drop Features
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Image Properties Editor

P EasyWorship - EasyWorship Support - Default =2 HEH ===
File Edit Live Profiles Help

S ™
Open Save New  Web
Schedule - 141207 Worship_2nd... 33 = | £+ | Live - We Will Glorify

- We Will Glorify
j Alas And Did My Savior ..
-' Genesis 1:1 (HCSB)

=

e com®

1
N
N
[T
h

9% v | Live Output =

—

We will glorify the King of kings
We will glorify the Lamb

We will glorify the Lord of lords
Who is the great I Am

Slide 1 of 4 S

File Name

Il I I

15457 15458 16288
6770 8817 9309

1 of 27 items 28 v

DISPLAY IMAGES

In the Resource area:

1. Click the Media tab.

2. Click the Images icon in the Resource Library below, then drag and drop the image
to the Schedule Area.

3. Selectthe image in the Schedule Area and click Go Live, OR double-click the image
to go live to the audience.
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ADD NEW IMAGES

EasyWorship comes with a collection of images ready for you to use in your present-
ations. But more than likely you'll want to add new background images that you've pur-
chased online or produced yourself. Here's how to add new images to your Images
Library.

Click the Media tab.
Select Images in the Resource Library on the left.

In the Images List Area (below Image thumbnails), click the + (Add) icon| + .

Browse to the image you want to import and select it.
Click Open.

o g M 0w Dh =

The imported image appears in the Images List Area.

NOTE:EasyWorship will display .bmp, .jpg, .wmf, png and .ico files. For the best results,
store all images in Your Profile/images folder. Where is your images folder located? To find

out how to locate your images folder, see and scroll down to the section titled
"Locate Your Profile Data."

RIGHT-CLICK FEATURES

When you right click on a thumbnail in the Images Resource Library, you have the fol-
lowing options:
1. Add New Image: this is a shortcut to adding additional images.

2. EditImage Properties: opens the Image Properties Editor, which allows you to add a
title, control the default aspect ratio for the image, and more.

3. Delete: deletes the image from the resource area. It will prompt you to delete it com-
pletely from the / Resources / Images folder.

4. View: allows you to change icon size for a custom thumbnail view.
5. Sort by: the same as in Windows.

6. Refresh: the same as in Windows.
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5 EesyWorship - Default (E=ESR
File Edit Live Profiles Help
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1.
2.

3.

Add to Schedule: Drag and drop an image into the schedule from the Images area.

Use as Background: Drag an image onto a song in the schedule to assign that image
to a song as a background.

Add a New Image: Drag and Drop images from any folder in Windows to the images
area. EasyWorship will then add a shortcut to that image into your images tab.

IMAGE PROPERTIES EDITOR

Follow these steps to edit the properties of any image in EasyWorship:

1.
2.
3.
4.

Click on the Media tab in the Resource Area.
Select Images from the Resource Library on the left.
Right-click on any image and select the option to Edit Image Properties.

The Image Properties editor will appear, allowing you to customize properties of the
image such as title, aspect ratio, copyright info., tags, etc.

Properties Tab

-100-



EasyWorship 6 Manual: Images

1. Title: Enter the name of the image in this field.

2. Aspect Ratio: Allows you to maintain the aspect ratio, stretch, or zoom the image.

Info Tab

1. Title: Enter the name of the image in this field.
2. Author: Enter the Author in this field.

3. ©Button: Enter copyright info in this field. Pressing the copyright logo button adds the
copyright logo to the copyright field.

4. Description: In the dropdown area, enter a description for the image (description
keywords are searchable from the search bar in the Resource Area).

5. Tags: In the dropdown area, enter tags for the image (tags are searchable from the
search bar in the Resource Area).

6. OK: Saves the Image properties and closed the window.

7. Cancel: Cancels all changes and closes the window without saving.

Back to Top
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NEWTEK NETWORK SOURCE SETUP

EasyWorship can be configured to be a network source for the NewTek Tricaster video
mixers over your local area network. It only takes a few clicks to setup EasyWorship so
that it can be used a network source for the Tricaster.

Open EasyWorship.

Click the Edit menu at the top of EasyWorship.
Click Options.

In the Live options change the Output Monitor to NewTek AirSend.

o M v N =

Select the Output Format you wish to send to the Tricaster unit from the dropdown
box.

6. Onthe Tricaster you can now select the EasyWorship computer as a network input.
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FEEDS

In this article:

1. Overview

2. Add aFeed
3. Edit a Feed
4

. Delete a Feed

OVERVIEW

EasyWorship can project images from your computer through external devices (e.g.,
DVD, VHS, Camera[s], Mixer) using a capture card. Most capture cards are PCl cards
that are installed into PCI slots on the motherboard of your computer. Each capture card
has its own input connections. Some are RCA (composite) jacks, some are S-video, and
some are FireWire IEEE1392. Itis important that you determine the type of interface
cable desired before you order your capture card.

NOTE: FireWire IEEE1392 has some latency that is noticeable. This option may not be desir-
able if your audience is watching the source and output screen at the same time (e.g.,

IMAG). Some capture cards do not work well with multiple cards of the same type. See Sys-

tem Requirements at
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ADD AFEED

1.
2.

Open EasyWorship.

In the Resource Area, click the Media tab and select Feeds from the Media Library
on the left.

Click the Action Menu button i~ atthe bottom of the List Area in the middle.

Select the option to Add New Feed, which brings up the Feed Editor window.

5. Under the Available Input Devices you will see <unassigned> and below that you

will see any input devices that are connected (e.g., a capture card, aweb camor a
USB input device).

Click the input device to which you want to connect.

7. Type a name for the device in the Name field. Example: Webcam.

10.
11.

Select the type of device from the Device list (options include a Camera, Mixer, DVD
player or a Misc. Player).

Under the Device Options you can customize the following properties:

» Resolution: defaults to 640 x 480 but can be changed from 1280 x 720
to 160 x 480.

» Frame Rate: defaults to 30 FPS.
» Color Space: YUY2 or MJPG.

» Aspect Ratio: defaults to Automatic, but can be changed to Maintain,
Stretch, or Zoom.

» Audio Properties: allows you to change the volume of the feed when
you go live with it. The volume slider allows you to set the volume of
the feed for playback to the audience. Mute allows you to mute the
audio on the feed if you don’t wish to use the audio portion of the feed.

Click OK when you are done.

The added device is listed in the Feeds Library in the Resource Area. To add addi-
tional devices repeat steps 1-10.
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EDIT AFEED

1. Inthe Resource Area, click the Media tab and select Feeds from the Media Library
on the left.

2. Inthe list area in the middle, right-click on the device that you want to delete and
select Edit.

3. Make the desired changes and click OK.

DELETE AFEED

1. Inthe Resource Area, click the Media tab and select Feeds from the Media Library
on the left.

2. Inthelist areain the middle, right-click on the device that you want to delete and
select Delete.

3. A message appears asking you if you want to permanently delete the feed.

4. Click Yes to delete the feed.

Back to Top
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SONGS: PRINTING & REPORTING

EasyWorship allows you to track song usage and generate song reports. EasyWorship
also has the option to print a list of the songs in your Songs Library. Each time you add,
print or project a song, EasyWorship tracks that action and stores it for you in a viewable
and printable file.

NOTE: To learn more about reporting the usage of songs for copyright purposes, please con-

tact Christian Copyright License International (CCLI) at www.CCLI.com.

PRINTING A SONG ACTIVITY REPORT

1. In EasyWorship's main menu bar, click on File.

2. Inthe drop down menu, use your mouse to hover over the Print option.
3. Inthe side menu, click on Print Song Activity Report.
4

. The Select Report Period window will appear. Enter the report period dates for
which you need an activity report.

5. Click OK.

6. When the report appears, navigate the top menu bar for options on saving, printing,
etc.

PRINTING A SONG LIST REPORT

1. In EasyWorship's main menu bar, click on File.

2. Inthe drop down menu, use your mouse to hover over the Print option.
3. Inthe side menu, click on Print Song List Report.
4

. The Song List will appear showing the alphabetical listing of the songs in your Songs
Library. You can navigate the top menu bar options for printing, saving etc.

PRINTING A SCHEDULE

Maybe you want your staff to be able to reference a hard copy of the service or event
schedule. No problem. EasyWorship lets you print a service schedule in either a summary
or detail view.

1. In EasyWorship's main menu bar, select File.

2. Inthe drop down menu, use your mouse to hover over the Print option.

- 106 -
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Back to Top
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WHEN TO USE CUSTOM POSITION

If you're building EasyWorship Schedules at home or using Display Foldback with the
Matrox DualHead2Go, then you need to understand how to take advantage of custom
position for the Output Monitor.

BUILDING SCHEDULES AT HOME

If a schedule is built on a computer using a different output resolution than the present-
ation computer, the songs will not display the same way on the presentation computer as
the source computer. Setting a custom resolution on the source computer will correct this
problem.

On the Presentation Computer

Determine the output screen size of the presentation computer.

1. Open Display Settings on the presentation computer.
2. Click on the second monitor.

3. The resolution for that screen will be displayed there, e.g., 1024x768.

On the Home Computer

1. Open EasyWorship on your home computer.
2. Inthe main menu, click Options.

3. Under Live, select Output Monitor and change Output Monitor to Custom
Position.

4. Change the Width and Height to match the presentation computer resolution (e.g.,
Width = 1024p x Height = 768p).

5. Click OK.

USING DISPLAY FOLDBACK WITH A MATROX DUALHEAD2GO

To find out how to set Custom Position for Display Foldback, see Display Foldback
(Stage Display).
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NEWTEK NETWORK SOURCE SETUP

EasyWorship can be configured to be a network source for the NewTek Tricaster video
mixers over your local area network. It only takes a few clicks to setup EasyWorship so
that it can be used a network source for the Tricaster.

Open EasyWorship.
Click the Edit menu at the top of EasyWorship.

Click Options.
In the Live options change the Output Monitor to NewTek AirSend.
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Select the Output Format you wish to send to the Tricaster unit from the dropdown
box.

6. Onthe Tricaster you can now select the EasyWorship computer as a network input.
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SONGS: PRINTING & REPORTING

EasyWorship allows you to track song usage and generate song reports. EasyWorship
also has the option to print a list of the songs in your Songs Library. Each time you add,
print or project a song, EasyWorship tracks that action and stores it for you in a viewable
and printable file.

NOTE: To learn more about reporting the usage of songs for copyright purposes, please con-

tact Christian Copyright License International (CCLI) at www.CCLI.com.

PRINTING A SONG ACTIVITY REPORT

1. In EasyWorship's main menu bar, click on File.

2. Inthe drop down menu, use your mouse to hover over the Print option.
3. Inthe side menu, click on Print Song Activity Report.
4

. The Select Report Period window will appear. Enter the report period dates for
which you need an activity report.

5. Click OK.

6. When the report appears, navigate the top menu bar for options on saving, printing,
etc.

PRINTING A SONG LIST REPORT

1. In EasyWorship's main menu bar, click on File.

2. Inthe drop down menu, use your mouse to hover over the Print option.
3. Inthe side menu, click on Print Song List Report.
4

. The Song List will appear showing the alphabetical listing of the songs in your Songs
Library. You can navigate the top menu bar options for printing, saving etc.

PRINTING A SCHEDULE

Maybe you want your staff to be able to reference a hard copy of the service or event
schedule. No problem. EasyWorship lets you print a service schedule in either a summary
or detail view.

1. In EasyWorship's main menu bar, select File.

2. Inthe drop down menu, use your mouse to hover over the Print option.
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PROFILES

In This Article:

Understanding Profiles

Create a New Profile

Create a Shared Database

Change Profiles
Edit a Profile

Locate Your Profile Data
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UNDERSTANDING PROFILES

Profiles consist of both User Settings and Application data. Application Data consists of
databases such as songs and backgrounds, along with videos, images, feeds and DVD
clips. User Settings consist of settings like font size, color and transition settings, as well
as information about the EasyWorship window size and location. Settings like the output
monitor setting are global settings that will affect all users and are not part of Profile set-
tings.

What is the benefit of Profiles? With a little bit of up front effort, Profiles let you store data-
bases in different locations and then associate multiple unique user settings to that applic-
ation data. Stated more simply, if Bob runs EasyWorship for the adults and Jennifer runs
EasyWorship for the youth group, they can both have access to the same resources
(songs, backgrounds, videos, etc), but have completely different user settings so
EasyWorship looks, acts and displays the way that fits their unique audience. Or, Bob and
Jennifer can create completely separate databases for their resources.

NOTE: The profile data can be stored on the local hard drive, on a server or shared network

folder. EasyWorship will create a Default profile in the following location. C:\User-
s\Public\Public Documents\Softouch\EasyWorship.
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Possible Profile Configurations

1. Use the same set of application data as another profile but different user settings.
(Example: Bob and Jennifer share the same resources [songs, backgrounds, videos]
but have different user settings so that Bob's slides are appropriate for the adults and
Jennifer's slides are appropriate for the youth.)

2. Use adifferent set of application data with the same user settings as another profile.
(Example: Bob and Jennifer have separate databases, so they don't mix resources
[songs, backgrounds, videos] but they have identical user settings.)

3. Use adifferent set of application data and a different set of user settings. (Example:
Bob and Jennifer have separate databases, so they don't mix resources [songs, back-
grounds, videos] and they also have different user settings.)

NOTE: EasyWorship also allows for easy hot swapping between Profiles. This means that

EasyWorship doesn't have to be closed when switching from one Profile to another.

Back to Top

The Profiles Menu

When you click Profiles in EasyWorship's main menu, you'll notice multiple options. At the
top are the names of all available Profiles that have been created ( "Default" is listed as the
only available Profile until additional Profiles have been created). To change Profiles,
select the profile you want to switch to.

1. Profiles Manager allows you to edit and create profiles in EasyWorship.

2. Database Tools has a Rebuild/Fix Database option. This checks the database for
errors and fixes them.

CREATE ANEW PROFILE

EasyWorship will create a default profile automatically when it is installed. If another set of
data or settings is desired, creating a new profile can accommodate this need.

Open EasyWorship

Click on the Profiles menu.

Click on Profiles Manager.

The Profiles Editor screen appears.

o r w0 N =

Click on either the + (Add) button or the New button to bring up the Add Profile

6. Under the General tab highlight the words New Profile and then either press the
7. ATer you type in the name that you want to Use, you can Click the OK pution to create
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8. Once you have created the new Profile, you can click the Close button or create
another Profile or edit an existing Profile.

8. Once you have created the new Profile, you can click the Close button or create
another Profile or edit an existing Profile.

NOTE: The default path location for Windows Vista, 7 and 8 it will be located in C:\User-

s\Public\Public Documents\Softouch\EasyWorship

Create a Shared Database

Open EasyWorship

Click on the Profiles menu.

Click on Profiles Manager.

The Profiles Editor screen appears.

Click on either the + (Add) button or the New button to bring up the Add Profile
menu.
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6. Under the General tab highlight the words New Profile and then either press the
backspace or delete key then type the name that you want to use for the shared data.
(e.g., Shared, Network, etc.)

7. Clickthe Advanced tab.

8. Change the Type to Existing.

9. Click the Browse button.
10. This will open the "Browse for Folder" window.
11. Click Browse to locate the shared profile folder.

12. For network databases, browse to Network Computer Name (e.g. WorshipPC)\
Users\Public\Public Documents\Softouch\EasyWorship\

13. Select the profile folder (e.g. Default).

14. Under Options, click in the open field and type in the name you want to use for this
profile's options, or select a name from the drop down list.

15. Click OK.

NOTE: If you want to return to the Profiles Manager after creating the new profile, uncheck

the option for "Start Using this profile when complete."

Back to Top
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CHANGE PROFILES

EasyWorship allows you to change profiles easily, giving you the ability to use different
databases and settings without closing the application.

1. Click on Profiles in EasyWorship's main menu.
2. Select the Profile you want to use.

3. EasyWorship will load that profile. If you have a Schedule open, EasyWorship will ask
you to close it before loading the selected profile.

NOTE: Determining which profile is currently loaded is also easy. The current profile is the

one with a black dot on it when you click on the Profiles menu.

EDIT APROFILE

To change the settings or folder location of a profile:

Open EasyWorship

Click on the Profiles Menu.
Select Profiles Manager.
Select the profile to be edited.
Click the Edit button.

The Profile Editor window appears.
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On the left you will have the list of your currant profiles (Example: Default). On the
right you will have the Profile Name, the location of the Profile Instance and then
Options name.

8. Select the profile that you want and click the Edit button.
9. You will see the General and Advanced tab.

10. Click the Advanced tab from here you can change the Type of profile from Existing
to New, specify where the profile is located and change the Options that are asso-
ciated with the profile.

LOCATE YOUR PROFILE DATA

You may eventually need to transfer your database from one computer to another or copy
videos or images into the Resources folder. To find the location of the data for your Profile,
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use the following steps:

Open EasyWorship.

Click on Profiles in the main menu.
Click on Profiles Manager.

Select the Profile.
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Click on the link next to "Instance Location.” This will open the folder where your
Default folder and your Resources folder are located.

6. Or, you can use Computer or Windows Explorer to browse to the "Instance Location"
on your hard drive to find your data files.

NOTE: The databases will be stored in a Databases folder in a folder called Data.
Videos and Images will be stored in the Resources folder. Options for the profile will be

stored in the Options folder.
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ALPHA CHANNEL SETUP

In this article:

What Is Alpha Channel?
Before Getting Started

Enable Alpha Key in EasyWorship
Enable Windows Extended Desktop

Ao Dd -

WHAT IS ALPHA CHANNEL?

Alpha channel is basically a mask. It determines how an object's pixel colors are going to
blend with pixel colors from another object when the two are overlaid. In EasyWorship,
when placing text (e.g., lyrics) or a transparent PNG (e.g., church logo) on top of a motion
background or live feed, alpha channel is the best way to generate clean, professional
edges around the text--especially important for IMAG, live stream or HD broadcast.

EasyWorship's alpha channel support was designed for those who have a video mixer
that uses alpha key to overlay text and graphics on a video source. Alpha channel keying
provides the best quality for text and graphic overlays.

BEFORE GETTING STARTED

Alpha channel support requires a single NVIDIA Geforce GTX series graphics card that
can support at least three simultaneous video outputs. Before using the alpha channel
function in EasyWorship, make sure your computer meets the system requirements for
alpha channel support. Connect the alpha channel and EasyWorship Output to the video
mixer and extend the Windows desktop to each output (see Enable Windows Extended

Desktop below).

The following instructions show you how to set up EasyWorship. They will not help you
configure your video mixer. Please consult the support resources for your mixer for help
configuring an alpha key on the video mixer.
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ENABLE ALPHA KEY IN EASYWORSHIP

Open the EasyWorship program.

In the main menu at the top, select Edit.

From the dropdown, select Options. The Live Options window will appear.
Change the Output Monitor option to the output you wish to use.

Change the alpha channel option to the output you wish to use for the alpha channel.
Select OK.

S O A

NOTE: If all of the video outputs do not appear in the dropdown boxes make sure the desktop

is extended to all displays. See below.

Back to Top
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ENABLE WINDOWS EXTENDED DESKTOP

1. Open EasyWorship.

2. Select the Edit menu.

3. Select Options.

4. The Options dialog box appears.

» Options =3 =R
Live Live Options
Song Select Qutput Monitor

Seripture Qutput Menitor | Custom Position - TriprlrEsen
Presentation Left [i] &
Alpha Channel Disabled hd

Foldback Top O
Song Width 1024 £
Scripture

Height 768 =
Miscellaneous

Advanced

Screen Margins

Transitions < =
Left 0 = Top 0 =
Right 0 3 Bettem O <
Auto Sizing
verse 1 —
=ong text line one Maximum font point size 46 =

song textline two

song text line three
song text line four

£ Prsin ot

5. Select the Live tab on the upper left.
6. Inthe section titled Live Options, select the Monitor Setup button.

7. EasyWorship will open the Screen Resolution dialog box.

=%~
{ H pv|!J <« Displ.. » Screen .. vl‘f” Searc

Change the appearance of your displays

Display: 2. SyncMaster «

Reszolution: 1024 = 768 (recommended)

Multiple displays: IShow desktop only on 1 V]

Make this my main display Advanced settings

Make text and other items larger or smaller

What display settings should I choose?

OK ] [ Cancel Eppl-}-'1 19 r
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NOTE: If there is only one monitor in the Screen Resolution window or you are unable

to extend the desktop to monitor, your video card may not support more multiple dis-
plays, or all video outputs may not be connected to a display.
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WHEN TO USE CUSTOM POSITION

If you're building EasyWorship Schedules at home or using Display Foldback with the
Matrox DualHead2Go, then you need to understand how to take advantage of custom
position for the Output Monitor.

BUILDING SCHEDULES AT HOME

If a schedule is built on a computer using a different output resolution than the present-
ation computer, the songs will not display the same way on the presentation computer as
the source computer. Setting a custom resolution on the source computer will correct this
problem.

On the Presentation Computer

Determine the output screen size of the presentation computer.

1. Open Display Settings on the presentation computer.
2. Click on the second monitor.

3. The resolution for that screen will be displayed there, e.g., 1024x768.

On the Home Computer

1. Open EasyWorship on your home computer.
2. Inthe main menu, click Options.

3. Under Live, select Output Monitor and change Output Monitor to Custom
Position.

4. Change the Width and Height to match the presentation computer resolution (e.g.,
Width = 1024p x Height = 768p).

5. Click OK.

USING DISPLAY FOLDBACK WITH A MATROX DUALHEAD2GO

To find out how to set Custom Position for Display Foldback, see Display Foldback
(Stage Display).
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VIDEO DECODERS FOR EASYWORSHIP 6

In this article:

1. What Is a Video Decoder?
2. Install Quicktime for MP4 and MOV files
3. Install DScaler for DVD Playback

WHAT IS AVIDEO DECODER?

When you play a video, or sound file through EasyWorship, it has to know how to decode
that file. A codec or decoder is a piece of software that tells EasyWorship how to decode
the video or audio file. If you don't have the proper codec installed on your computer,
EasyWorship won't be able to play your multimedia file. EasyWorship requires Quicktime
player in order to play MP4, M4A, M4V and MOV files. See the instructions below for how
to install Quicktime player. EasyWorship also requires the DScaler 5.0.0.8 decoder to play
DVDs. Instructions for downloading and installing the DScaler decoder are also provided
below.

INSTALL QUICKTIME FOR MP4 AND MOV FILES

1. Open EasyWorship, click on the Helpmenu at the top of EasyWorship, then click on
Install Quicktime Support.

2. Click Download on the Install Quicktime box that appears.
3. Your web browser will open and direct you to the quicktime download page.

4. You do not have to enter any information on this page, just click the blue Download
Now button.

5. After downloading the Quicktime installer, open it and install it using the default
options provided in the install wizard.

6. Close and reopen EasyWorship. EasyWorship is now able to play MP4, M4V, M4A
and MOV files.
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INSTALL DSCALER 5.0.0.8 FOR DVD PLAYBACK

1. Close the EasyWorship program.
2. Click here to access the DScaler download page at sourceforge.net.

3. The download should start automatically. If not click the direct link option provided.
Don't click any other links or buttons on this page.

4. Allow the DScaler5008.exe file to download, then open it to start the install.

5. There are no special options to select during the install, use the default settings to com-
plete the install.

6. Open EasyWorship 6, click on Edit then Options.

7. Click Advanced and make sure you have checked the box next to use preferred
DVD codecs and click OK.

NOTE:EasyWorship will support WMV and WMA files without the use of additional video

decoders.

Back to Top
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TRANSFER YOUR DATABASE

The following instructions will help you transfer the EasyWorsip database from one com-
puter to another.
Before starting this process , you will need a USB flash drive or external hard drive.

BACKUP & TRANSFER EASYWORSHIP 6 DATABASE TO
ANOTHER EASYWORSHIP 6 COMPUTER

Backup Your Database

L e A
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Connect your backup drive to the computer.

Close all other programs and windows before starting.

Open EasyWorship 6

Click Profiles, then profiles manager.

Select your profile then click on the link next to Instance Location: on the right.

Close the profile manager and EasyWorship 6 (behind the file manager window that
appears).

In the file manager window that appeared on the step 5, select all folders.

Right click on any of the selected folders. Select Send to and select the flash drive or
external hard drive.

When the files are all transferred, disconnect the drive from the computer.
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Restore Your Database

—
e

11.

12.
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Connect your backup drive to the computer you wish to restore the database to.
Close all other programs and windows before starting.

Open the file manager, or click on computer and browse to your backup drive.
Select the folders you backed up and press ctrl+c or right click and click copy .
Open EasyWorship 6.

Click on the profiles menu, then profile manager.

Select the profile you wish to restore the database to.

Click on the link next to Instance Location: on the right.

Close the profile manager and EasyWorship 6 (behind the file manager window that
appears).

Rename all of the folders in the window that appeared on step 7 by adding a 1 after
the folder name.

Right click on a blank area (make sure you are not right clicking any folders you
renamed) then click paste or press ctrl+v to paste.

Open EasyWorship 6 to verify your database has transferred.
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TRANSFER DATABASE FROM EASYWORSHIP 2007/2009 TO
EASYWORSHIP 6 COMPUTER

On the EasyWorship 2007 or 2009 computer

1. Open EasyWorship 2009 on the old computer.
2. Click on profiles, profiles manager.

3.
4

Edit the profile you normally use.

. Click the field below Use and existing application data instance, use the right arrow

key to move the cursor to the end of the field.

Write down the path shown there including the name of the folder at the end of that
path.

Close the profile manager and close EasyWorship.

7. Open windows explorer or Computer.

10.

Browse to the folders in the path you wrote down.
The typical location is c:\users\public\public documents\softouch\easyworship

Copy the profile folder you are using to a flash drive.

Take the flash drive to the EasyWorship 6 computer.

On the EasyWorship 6 Computer

1.
2.

With EasyWorship 6 closed browse to the backup drive.

Right click on the profile folder and click copy.
Browse to c:\users\public\public documents\softouch\easyworship

If a folder with the same name is already there (example: default) rename it to a dif-
ferent name.

Right click on a blank area of the window and click paste, making sure you are not
pasting into the folder you just renamed.

Open EasyWorship 6 and allow it to convert the database.
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If you do not have a profile with the same name as the folder you trans-

ferred.

Open EasyWorship 6.

Click profiles.

Profiles manager.

Click the plus button to add a new profile.

Enter the name of the folder you transferred into the profile name filed.

Click advanced and change the type to existing and click ok.
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It should then ask you to convert the database.
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| HAVE A NEW COMPUTER WHAT DO | DO?
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On the new computer go to www.easyworship.com/support

Download and install EasyWorship 6.

Register EasyWorship 6. See Video: How to Register EasyWorship 6

Transfer the database from the old computer using the Transfer Your Database
instructions.

5. Install Quicktime Player from the help menu in EasyWorship 6.

6. Install DScaler video decoder 5.0.0.8 for Playing DVDs from the Video Decoders art-

icle.

Setup your monitors using the instructions in the Dual Monitor Setup article.

If you need to install demo songs, close EasyWorship 6, then download an run the
demo song installer the following link. http://tinyurl.com/Imyhybt
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USING A PRESENTER REMOTE

If you have at least EasyWorship 6.1.5 you can use a presenter remote to control
EasyWorship.

If you had a programmable remote setup to work with EasyWorship 2007
or 2009 it should work with EasyWorship 6.

The standard hotkeys for EasyWorship 6 are: PgDown = Go Live, Arrow Down = Next
Slide, Arrow Up = Previous Slide.

If you have a presenter remote that cannot be programmed to match
EasyWorship hotkeys follow the instructions below.Changing Hotkeys
Using the Hotkey Installer

You can download hotkeys file that will work for most presenter remotes.

Close EasyWorship 6
Click Here to download the hotkey installer.

Allow the file to run and replace any files it asks to replace.
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Open EasyWorship and test your remote. Make sure you click in the live area with
your mouse when testing.

5. If you wish to reset the hotkeys file to the default settings, download and run the
Hotkeys Reset file.

Changing Hotkeys Manually

1. Close EasWorship 6.

Go to start, run or right click the start button and click run Or search for "run" and open
it.

N

In the run box that appears type in %programdata% and press enter.
Double Click softouch : EasyWorship.v6.1 : settings

Double click on hotkeys.ini
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When windows asks what to open the file with, select notepad.

You will see this.
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[HotKeys]
BlackScreenKeys=C-66
ClearScreenKeys=C-67
GoLiveNextKeys=34
GoLivePrevKeys=33
JumpBridgeKeys=66
JumpChorusKeys=67
JumpEndingKeys=69
JumplntroKeys=73
JumpPreChorusKeys=82
JumpSlideKeys=83
JumpTagKeys=84
JumpVerseKeys=86
LogoScreenKeys=C-76
ScheduleNextKeys=39
SchedulePrevKeys=37
SlideFirstkKeys=36
SlideLastKeys=35
SlideNextKeys=78, 40, 32
SlidePrevKeys=80, 38, 8
7. You'll need to change a few of these.

If your remote is moving you to the next item in the schedule, it uses page up
and page down to navigate slides.

Make the following changes.
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” Change GoLiveNextKeys to 0 (zero)
” Add 34 to SlideNextKeys (SlideNextKeys=78, 40, 32, 34)
” Change GoLivePrevious to 0 (zero)

»” Add 33 to SlidePrevKeys (SlidePrevKeys=80, 38, 8, 33)

If you are using a remote that is selecting the next or previous item in the sched-
ule but not going live, you have a remote that uses left and right arrow keys to
navigate slides.

Make the following changes.

»” Change ScheduleNextKeys to 0 (zero)

» Add 39 to SlideNextKeys (SlideNextKeys=78, 40, 32, 39)
»” Change SchedulePrevKeys to 0 (zero)

»” Add 37 to SlidePrevKeys (SlidePrevKeys=80, 38, 8, 37)

8. Save thefile (ctrl+s),

9. Close notepad and open EasWorship 6.

10.
11.

Go live with a song or PowerPoint.

Click on the first slide and the remote will be able to navigate the slideshow.
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